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Accessibility Options (Win 95/98/2000/XP)

Publisher
Microsoft Corp.
One Microsoft Way
Redmond, WA 98052-6399
(206) 635-7245
http://www.microsoft.com/enable
Retail Cost: Included in OS

System Requirements
The Accessibility Options are found in the Windows 95/98/NT/2000/XP Control
Panel which is accessed through Settings on the Start menu. The Accessibility
Options are included in the default Windows 95/98/NT installation. Microsoft
accessibility applications (e.g., Narrator, Magnifier, etc.) are available through the
Start Menu, Programs, and Accessories.

Description
The Accessibility Options include five types of adaptive system support: Key-
board, Sound, Display, Mouse, and General. Additional accessibility applications
are available through the Accessories menu under Programs in the Start menu.

Recommended Uses
The Options provide system support for: persons with physical difficulty in using
the keyboard; persons who have visual disabilities and need larger print; stronger
contrasts or larger mouse pointer; persons who are deaf or hard of hearing and
need to see sound events; and, persons using a serial device to connect to the
computer. What is singular about this cluster of operating system support is the
fact that previously, almost all of these features had to be purchased from third
party vendors.

Basic Use
1. Enter Ctrl-Escape to bring up the Start menu.

2. Double Click on Accessibility Options. The Accessibility Properties
window appears.

3. Click on a properties tab to go to a support feature.

The Keyboard Properties Tab
Three features, StickyKeys, FilterKeys, ToggleKeys, are available; each has a
settings window, which is reached by clicking on a Settings button.
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StickyKeys

Use sticky keys to latch the special keys (Ctrl, Alt) or the shift keys. When one of
these keys is pressed, it latches and releases only when a second key is pressed,
e.g., Ctrl-P. Tapping shift or a special key twice latches it down (e.g., to type many
asterisks); tapping it again will unlatch it if that option has been set. This feature is
used when the keyboard user is unable to hold two keys down at the same time.

The keyboard shortcut to turn sticky keys on is to tap the Shift key 5 times. There
are additional options which may be selected for the StickyKeys feature: turn off
StickyKeys when two keys are depressed at the same time (automatically turning
the feature off for a regular typist), make a sound when a special key is pressed,
and a very important feature, the ability to show a visual display of whether a
special key is latched or not (not available in NT). Having the visual display on
the screen is useful information for persons with short term memory deficits.
Right clicking on this reminder brings up an option to adjust settings.

FilterKeys Properties Tab

There are two types of options that may be set from the main FilterKeys property
sheet. The one most frequently used is the second radio button option. This con-
trols the function of RepeatKeys and SlowKeys.

RepeatKeys

This option will override settings on the Keyboard control panel. It is possible to
turn off keyboard repeat entirely, or is it possible to slow down the rate at which
the key repeat function repeats. Students with slow visual processing speeds
benefit from a slowed key repeat function because it is easier to track the cursor.
Students who are unable to quickly lift their hands off a key will benefit from
having the repeat delay increased (a finger can stay on a key a bit longer before a
key repeat begins).

SlowKeys

The SlowKeys function allows the user to set a time delay before a keystroke is
registered. This in effect can create a virtual keyguard for the student who strikes
many keys while moving over the keyboard to the target keystroke. No keystroke
will be registered until a key has been depressed for a minimum length of time.

The keyboard shortcut which turns FilterKeys on is to hold down the Right Shift
key for eight seconds. This option will not work unless the Use shortcut box is
selected.

ToggleKeys

Choosing this function invokes a tone when one of the special locking keys is
pressed (Caps Lock, Scroll Lock, Num Lock).
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The Sound Properties Tab
At the current time, only one of the two options works: SoundSentry. Using this
option generates visual warnings when a system sound occurs. From its Settings
window, it is possible to have alerts for windowed programs or full screen text
programs (not available in NT).

For Windowed Programs
Flash active window or flash the desktop

For Full Screen Text Programs
Flash display, characters, or border

The ShowSounds feature will display captions for speech and sounds generated by
an application which has been designed to work with this feature. Currently this
feature is not widely supported.

The Display Properties Tab
From the front of this panel it is possible to invoke High Contrast color scheme if
an application is “smart” about this feature. The Settings window allows the user
to choose to invoke the shortcut key, Left Alt-Left Shift-PrintScreen, and to set
specialized high contrast color schemes.

It is possible to set everything to white on black or black on white, or specialized
color sets. Many color sets come with standard, large and extra-large font choices.

The Mouse Properties Tab
Only one set of functions is controlled by this tab: the ability to use the numeric
keypad to move the mouse pointer. It is possible to modify cursor speed as well as
to use Ctrl to speed up mouse movement and Shift to slow down mouse move-
ment.

The General Control Panel Tab

Automatic Reset

From this level it is possible to set a time limit on keyboard inactivity; when that
limit is reached, all accessibility functions automatically turn off.

Notification

It also is possible to ask for warning messages when features turn on (not available
in NT), or to set a sound to occur when a feature is turned on and off.

SerialKey Devices

For students needing to connect serial communication devices to a computer, this
access panel allows the user to set which serial port to use and what baud rate to
use.
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Installation
The Accessibility Options control Panel is part of the default Windows installa-
tion. If it is not installed, do so by going to the Windows Setup or Windows NT
Setup tab of the Add/Remove Programs Control Panel. Check the box next to
Accessibility Options and click OK. If the files are not on the local or network
drive, you may have to insert the CD when asked.

Accessibility Wizard
The Accessibility Wizard is located in Accessories, under Programs in the Start
Menu. The purpose of the Accessibility Wizard is to customize the Windows
environment according to the needs of the individual using the computer. With the
Accessibility Wizard, it is possible to manipulate font size, color schemes, cursor
variables, and scroll bar sizes to facilitate navigation and interaction within the
Windows environment.

It is now possible to save the settings that you wish to use at another computer
station. During the Accessibility Wizard, you may save your settings on the local
computer. This saves a .acw file, which can then be saved to a disk and moved to
another computer. To load the new settings, move the .acw file to the local com-
puter and open the file. This will automatically begin the Accessibility Wizard
with your settings enabled.

To reset the Windows interface to the original settings (i.e., remove accessibility
related formatting), perform the following steps

1. Start the Windows Accessibility Wizard.

2. Select “Use usual text size for Windows”.

3. Deselect all checkboxes in the Display Settings dialog box.

4. Click on the “Restore Default Settings” button.

5. Continue until you reach the Completing the Accessibility Wizard dialog
box to verify the changes you have made to the Windows environment.

Windows Magnifier
The Windows Magnifier is a screen enlargement utility designed to magnify the
visual environment of the computer screen. Upon starting the Windows Magnifier,
the screen will divide into two separate views. The magnified view region can be
resized or moved about the screen depending on the needs of the user. It is impor-
tant to recognize that the Windows Magnifier provides a minimum level of acces-
sibility for individuals with a visual impairment. For maximum functionality, it is
recommended to select a commercially available screen-magnification product
(e.g., ZoomText Xtra, Magic, etc.).

Windows Magnifier can

1. Increase magnification from 2x to 9x.
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2. Invert screen colors or allow for a high-contrast view.

3. Follow the mouse cursor, keyboard focus, and text editing around the
screen (These options are selected in the Tracking section of the Magnifier
control panel).

4. Change the size of the magnification window depending on the needs of
the user.

Windows Magnifier can be activated through the Accessibility folder (under Start
Menu, then Programs, then Accessories). Alternatively, it is possible to start
Windows Magnifier by opening the Run dialog box (in the Start Menu) and
entering “magnify” in the text area. This will begin the Windows Magnifier
application.

Windows Narrator
Narrator is a text-to-speech utility for users who are blind or have low vision.
Narrator reads what is displayed on your screen: the contents of the active win-
dow, menu options, or the text you have typed. Narrator is designed to work with
Notepad, Wordpad, Control Panel programs, Internet Explorer, Windows desktop,
and Windows setup. Narrator may not read words aloud correctly in other pro-
grams. It is important to recognize that the Windows Narrator provides a mini-
mum level of accessibility for individuals with a visual impairment. For maximum
functionality, it is recommended to select a commercially available screen-reader
product (e.g., JAWS, Window-Eyes, etc.).

Windows Narrator can be activated through the Accessibility folder (under Start
Menu, then Programs, then Accessories). Alternatively, it is possible to start
Windows Narrator by opening the Run dialog box (in the Start Menu) and
entering “narrator” in the text area. This will begin the Windows Narrator appli-
cation.

Navigating using Windows Narrator

To read an entire window
CTRL+SHIFT+SPACEBAR

To get information about the current item
CTRL+SHIFT+ENTER

To get a more detailed description of an item
CTRL+SHIFT+INSERT

To read the contents of an edit field
CTRL+SHIFT+ENTER (you may also use the arrow keys)

To silence the speech
CTRL
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Changing the Voice Settings
In the Voice Settings dialog box, you can select the voice options you want to
change. You can raise or lower the speed of the voice, the volume of the voice, or
the pitch of the voice. Select the Voice… button from the Windows Narrator
control panel. The Voice Speed, Voice Volume, and the Voice Pitch can all be
varied using the up or down arrows next to each value.

On-Screen Keyboard
On-Screen Keyboard is a utility that displays a virtual keyboard on your screen
and allows users with mobility impairments to type data using a pointing device or
joystick. On-Screen Keyboard is intended to provide a minimum level of function-
ality for users with mobility impairments. It is also useful for users who do not
know how to type. It is important to recognize that the On-Screen Keyboard
provides a minimum level of accessibility for individuals requiring keyboard
assistance. For full functionality, it is recommended to select a commercially
available keyboard assistance product (e.g., Half-Qwerty, Speech-to-Text applica-
tion, etc.).

On-Screen Keyboard has three typing modes you can use to type data

1. In Clicking mode, you click the on-screen keys to type text.

2. In Scanning mode, On-Screen Keyboard continually scans the keyboard
and highlights areas where you can type keyboard characters by pressing a
hot key or using a switch-input device. The Block keyboard layout works
well when using Scanning mode.

3. In Hovering mode, you use a mouse or joystick to point to a key for a pre-
defined period of time, and the selected character is typed automatically.

Selecting a keyboard layout

Selecting a keyboard layout is important when addressing the access needs of the
user. There are several keyboard layouts that can be selected in order to increase
the functionality of the On-Screen Keyboard application. Listed below are the
different options that may be selected from the Keyboard option on the menu bar.

Enhanced Keyboard
Includes the numeric keypad

Standard Keyboard
Displays a keyboard without the numeric keypad.

Regular Layout
Displays the keys as they would normally appear on a standard keyboard.

Block Layout
Displays the most frequently used character keys together on the keyboard.
Block layout also puts the directional arrow keys in the lower right corner.
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101 keys
Selects the U.S. standard keyboard

102 keys
Selects the universal keyboard

106 keys
Selects the keyboard with additional Japanese characters.

Selecting the correct mode

On-Screen Keyboard provides several different modes that may be utilized in
combination with other assistive computer technologies to provide a means to
interact with the computer. Listed below are the different options that may be
selected under the Typing option from Settings on the menu bar.

Hover to select

Select the up or down arrow to adjust the minimum hover time. If the mouse
pointer remains over a character for the specified hover time, the character will be
selected and typed.

Switch or key to select

Use the up and down arrows next to the seconds box to set the speed for how
quickly On-Screen Keyboard scans.

For additional functionality, select Advanced, and then choose the appropriate
option to do one of the following

Select Serial, parallel, or game port to designate that a pointing device, which
can be attached to the serial, parallel, or game port, will be used to select the
highlighted keyboard characters you wish to type.

Select Keyboard key to designate a key to be used to select the highlighted
keyboard characters you wish to type, and select the key from the pull-down
menu.

Utility Manager
Utility Manager enables users to check an Accessibility program’s status, and start
or stop an Accessibility program. Users with administrator-level access can desig-
nate to have the program start when Windows 2000/XP starts. The built-in pro-
grams accessible from the Utility Manager are Magnifier, Narrator, and On-Screen
Keyboard. Narrator, a text-to-speech program, starts automatically when Utility
Manager opens. This gives users who are blind or have low vision immediate
access to Utility Manager. As an example of the timesaving value of Utility Man-
ager, if you use the visual aid Magnifier, you can specify that Magnifier start
automatically the next time you turn on your computer. This eliminates the need
for you to go through the steps of opening Magnifier each time you start Windows
2000/XP.
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To choose which programs you wish to run, select the appropriate application in
the Utility Manager window. You may then choose to have the application “Start
automatically when Windows starts” or to “Start automatically when Utility
Manager starts”. If a checkbox is grayed out or cannot be selected, you may not
be part of the administrative group for the computer, or network policy settings
may prevent you from changing the settings in the Utility Manager. Contact your
system administrator for information if you need to select these options in the
Utility Manager control panel.

Dragon NaturallySpeaking v. 7.0
(Win 98/NT/2000)

Publisher
ScanSoft, Inc.
9 Centennial Drive
Peabody, MA 01960
United States
Tel: 978-977-2000
Retail Cost: Preferred $199.00 approx. Professional $695.00 approx.

System Requirements
Minimum: 650-MHz Intel¨ Pentium¨ III processor with MMXª, or equivalent,
IBM¨ compatible PC, Windows¨ 98/2000, or Windows NT¨ 4.0 (with Service
Pack 3 or greater). Memory Requirements: Minimum: 256 MB RAM (512 MB
is recommended). Hard Drive Requirements: 200 MB free hard-disk space, CD-
ROM drive for installation. Audio: Creative Labs¨ Sound Blaster¨ 16 or equiva-
lent sound board supporting 16-bit recording.

Description
Dragon NaturallySpeaking is a speaker dependent, continuous speech recognition
system. The active vocabulary size is 300,000 words with a word dictionary that
allows for accurate word prediction and spelling. Text can be dictated at around
one hundred to one hundred fifty words per minute. The system accommodates
multiple voice profiles per computer.

Features of Preferred and Professional include the following: Select-and-Sayª
editing, convenient Dictation Playback and Text-to-Speech to speed editing and
proofreading, and the ability to launch applications and drop-down menu com-
mands by voice. “Mouse Grid,” a verbal mouse, is also available. Users can
navigate the Internet by speaking URLs and into fields in Web pages when using
Internet Explorer.
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Professional also includes macro capabilities and is required to use Jawbone or to
network the software.

Recommended Uses
This program is recommended for persons with repetitive strain injury or moder-
ate to severe physical disabilities that impair keyboard usage. In some cases, users
who have learning disabilities or who speak English as their second language may
also benefit.

Accents or difficult to understand speech is not a problem as long as the speech
patterns are consistent. Users must be able to produce consistent speech output for
success with this program.

More than the criteria of disability, success is dependent on personality. Potential
users must have the patience to train the program, learn the commands, and apply
the commands correctly in order to preserve and improve their speech profiles.

Basic Use
Each user must individually train Dragon NaturallySpeaking. Training is accom-
plished through use of the General Training program. Creating a voice profile and
completing the training process takes about 15 minutes unless you have a slower
computer, which will increase training time. NaturallySpeaking works within its
own dedicated word processing environment as well as within many popular
applications, including Microsoft Office. When using NaturallySpeaking, the
following steps are taken

1. Load NaturallySpeaking from the Programs menu.

2. Activate the microphone by pressing the numeric keypad + key.

3. Begin speaking clearly and distinctly in short phrases with brief pauses
between each phrase.

4. If a phrase or word selected by NaturallySpeaking is incorrect say
ÒCorrect" and the word or phrase to be corrected.

5. If the correct phrase or word appears in the suggestion list, say “Choose”
and then the number of the desired phrase or word in the selection box.

6. If the desired phrase or word does not appear in the selection box, say
ÒSpell That" and begin spelling the word using the letters of the alphabet.
Generally, the correct phrase or word will be identified after the first one or
two letters have been spoken. When the desired phrase or word appears,
say “Choose” and the number of the phrase or word.

Intermediate Use
Users can insert punctuation marks by saying the name of the mark, (i.e. “period,”
“comma,” “question mark”). A variety of options exist for selecting text. Saying
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“Select” then word, line, paragraph or document selects a portion of text that
can then be edited or formatted in a number of ways. (See attached Quick Refer-
ence Guide).

Reading Text

Listening to text that has been dictated provides a useful method for identifying
recognition errors. NaturallySpeaking provides two methods for listening to
dictated text

To play back digitally recorded speech of your voice dictating text, select the text
to be read (i.e. say “select previous paragraph”) then say “play that back.” Please
note that this option only works for text that has not been previously saved and
then reloaded.

To play back computer-generated speech of any text in the NaturallySpeaking
composition window, select the text to be read (i.e. say “select previous para-
graph”) then say “read that.” This option works for any text file.

Mouse Grid

NaturallySpeaking provides a Mouse Grid navigation system similar to that used
in previous and current versions of Dragon Dictate to move the mouse pointer.
Saying “MouseGrid” displays a 3x3 grid with nine numbered squares which
cover the entire screen. Saying the number of a square “refocuses” the grid to the
selected square. Repeating the selection process moves the mouse pointer to the
desired object by a process of approximation. Saying “click” selects the object.

Saying “MouseGrid” opens the Mouse Grid in the current window. Additional
fine-tuning of the mouse pointer can be accomplished by using a limited set of
mouse movement commands. Say “mouse (up, down, left or right)” followed by a
number between 1 and 10, will move the mouse a few pixels in the selected
direction. For example, saying “mouse up 9” will move the mouse pointer up
about one-eighth of an inch.

Advanced Use

Using Internet Explorer by Voice

Start Dragon NaturallySpeaking before you start Internet Explorer. If Internet
Explorer is already running, close it. Start Dragon NaturallySpeaking, then restart
Internet Explorer. A NaturalWeb splash screen appears when Internet Explorer
starts. When it disappears you can use voice commands to control Internet Ex-
plorer, including following links and dictating into editable areas on Web pages,
such as boxes on forms.

Following links or clicking buttons by voice

To follow a link or click a button by voice, just say the link or button text or part
of the text. You can also say “Click” followed by all or part of the text. You can
only follow links that you see on your screen. To follow a link that is low on a
page, scroll down until you can see it and then say the link.
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A red arrow shows the link or button that is being followed.

If multiple links or buttons match

If more than one link or button matches what you said, an arrow with a question
mark appears next to the first one.

1. To click the selected link or button, say “Click That,” “That One,” or
“Click That One.”

2. To go to the next match say “Next,” “Next Control,” or “Next Match.”

3. To go to the previous match, say “Previous,” “Previous Control” or “Previ-
ous Match.”

If a link or button does not have text

If you want to follow a link or click a button that does not have text, first say the
word or words that best describe the picture. Often, a graphic hotspot has an
internal identifier (ALT or NAME) associated with it, and if you say either of
these, Dragon NaturallySpeaking will follow the link. If this fails, try the follow-
ing

1. Say “Image” to go to the first picture.

2. Say “Next” or “Next Match” until you get to the link you want to follow.

3. Say “Click That” to click the picture.
• If an image link has an ALT identifier, the Browser may show you the ALT

text when you hold the mouse over the image for a short time. You can
then say the text you see to follow the link.

• The arrow indicator does not appear in secure documents.

Vocabulary Optimizer
In order to improve recognition accuracy, NaturallySpeaking provides a Vocabu-
lary Optimizer option that extracts, analyzes and stores specialized vocabulary
drawn from documents you’ve submitted for review.

Installation
For NT installations, always login as Administrator for that computer. Insert the
CD into the drive and wait for the install program to start. If your PC does not
have autorun enabled, you will have to run setup either from the run command or
by browsing in the Explorer. Follow the onscreen directions to install the program.

Most problems with Dragon NaturallySpeaking stem from a poor signal to noise
ratio. This may be caused by any of the following: incompatible sound card, a bad
microphone, microphone not matched to sound card which may need a booster
pack installed, poor voice quality such as not loud enough or inconsistent speech
production. High quality microphones are recommended to compensate for these
problems.
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NaturallySpeaking Commands

Dictating text quick reference

These are the essentials of dictating text
Start dictating
Say whatever you want to say, speaking normally in phrases
Start a new paragraph (press Enter twice)
Say “New Paragraph”
Start a new line (press Enter once)
Say “New Line”
Enter punctuation marks, such as (!)
Say the punctuation mark, such as “exclamation point”
Dictate symbols or special characters such as @
Say the standard name of the symbol such as “at sign”

To dictate numbers

In most cases you can dictate numbers, including Zip codes, as you normally say
them. For more detail on how to dictate numbers, see Dragon NaturallySpeaking
User’s Guide.

Examples
To enter Say
4 “four” or “numeral four”
23 “twenty-three”
179 “one hundred seventy nine”
5423 “five thousand four hundred twenty three”
5,423 “five comma four twenty three”
142,015 “one hundred forty two thousand and fifteen”
0.03 “zero point oh three”
2 ¾ “two and three fourths”
11/32 “eleven over thirty two”
965-5200 “nine six five fifty two hundred”
617-965-5200 “six one seven nine six five five two hundred”
$45 “forty five dollars”
$99.50 “ninety-nine dollars and fifty cents”
8:00 “eight o’clock”
8:30 p.m. “eight thirty pm”
May 15, 2003 “May fifteen comma two thousand three”
MCMLIX “Roman one thousand Roman one hundred Roman one

thousand Roman fifty Roman nine”

Punctuation and symbols

You can enter the following punctuation marks and symbols in the text you dic-
tate. If the same punctuation mark appears more than once, Dragon
NaturallySpeaking treats the character differently depending on what you say. For
example, an apostrophe immediately follows the preceding text, while an open
single quote is preceded by a space.
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To enter Say
& ampersand

and sign
’ apostrophe
‘ begin single quote

open single quote
’ close single quote

end single quote
’s apostrophe ess
* asterisk
@ at sign
‘ backquote
\ backslash
^ caret
: colon
: numeric colon
, comma
, numeric comma
— dash
$ dollar sign
. dot

point
. period
É ellipsis
= equal sign
! exclamation point

exclamation mark
/ forward slash

slash
- hyphen

numeric hyphen
{ left brace

open brace
} close brace

right brace
[ left bracket

open bracket
] close bracket

right bracket
( left paren

left parenthesis
open paren
open parenthesis

) right paren
right parenthesis
close paren
close parenthesis
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< left angle bracket
open angle bracket

< less than
> close angle bracket

right angle bracket
> greater than
– minus-sign
# number sign

pound sign
“ begin quote

begin quotes
open quote
open quotes

” close quote
close quotes
end quote
end quotes

% percent sign
+ plus sign
? question mark
; semicolon

space bar
(tab) tab key
~ tilde
_ underscore
| vertical bar
:-( frowny face
:-) smiley face
;-) winky face

To add new lines and paragraphs

While you are dictating, use the following commands
To Say
Start a new line (press the Enter key once) “New Line”
Start a new paragraph (press the Enter key twice) “New Paragraph”

• Saying “New Paragraph” is equivalent to pressing the Enter key twice
(since this is what many people do when typing a document). Saying “New
Line” is equivalent to pressing the Enter key once.

• New Paragraph capitalizes the next word you dictate.
• New Line does not capitalize the next word.

Dictation commands

When you are dictating, you can say the following dictation commands without
pausing.
Say To
“New Line” Press the Enter key once
“New Paragraph” Press the Enter key twice, capitalize next word
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“Cap <word>” Type <word> with an initial capital
“Caps On” Start typing words with initial capitals
“Caps Off” Stop typing words with initial capitals
“All Caps <word>” Type <word> in all uppercase
“All Caps On” Start typing words in all uppercase
“All Caps Off” Stop typing words in all uppercase
“No Caps <word>” Type <word> in all lowercase
“No Caps On” Start typing words in all lowercase
“No Caps Off” Stop typing words in all lowercase
“No Space <word>” Do not put a space before <word>
“No Space On” Stop putting spaces between words
“No Space Off” Start putting spaces between words

• To enter the word “cap” (as in “baseball cap”), pause after saying “cap.”
• The capitalization and spacing modes are automatically canceled if you

move around your document.

Move to the beginning and end of documents and lines

You can use these commands to move to the top or bottom of a document and the
beginning or end of a line.
Say Then say
“Go to” “Top”
“Move to” “Top of Document”

“Beginning of Document”
“Start of Document”
“Bottom”
“Bottom of Document”
“End of Document”
“Beginning of Line”
“Start of Line”
“End of Line”

Examples
“Go to Top”
“Move to End of Line”
• These commands deselect any text that is selected.

Move around by lines and paragraphs

You can use these commands to move around by lines and paragraphs.
Say Then say Then say
“Move” “Up” “a Line”

“Back” “1 Line”
“Down” “2-20 Lines”
“Forward” “a Paragraph”
“1 Paragraph
“2-20 Paragraphs”

Examples
“Move Up a Line”
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“Move Down 8 Lines”
• These commands deselect any text that is selected.

Move around by words and characters

You can use these commands to move around by words and characters.
Say Then say Then say
“Move” “Right” “a Word”

“Forward” “1 Word”
“Left” “2-20 Words”
“Back” “a Character”
“1 Character”
“2-20 Characters”

Examples
“Move Right 3 Words”
“Move Left 4 Characters”
• These commands deselect any text that is selected.

Move the cursor

You can use these commands to move the cursor up, down, left, and right. To use
these commands press the corresponding arrow keys.
Say Then say Then say
“Move” “Up” 1-20

“Down”
“Left”
“Right”

Examples
“Move Right 3”
“Move Up 5”

Revising text: quick reference

You can revise text by voice in any of the following ways

Delete text
Say “Scratch That”

Select text
Say “Select <text>” where <text> is the word or phrase you want to change or
“Select <text> through <text>.”

Change text once you have selected it
Say the words you want to replace the selection with.

Back up and resume dictating
Say “Resume With <word>” where <word> is the word you want to back up
to. Then, dictate the revised text.
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Important
• When you use these commands to revise text, Dragon NaturallySpeaking

does not learn from its mistakes. If you want Dragon NaturallySpeaking to
learn, so errors are less likely to recur, you should correct recognition
errors.

To play back dictation in a document

1. Move the cursor to or select the words you want to play back.

2. Say “Play That Back” to play selected text, or say one of the following
commands

“Play Back Line”
“Play Back Paragraph”
“Play Back Document”
“Play Back Screen”
“Play Back Window”
“Play Back to Here”
“Play Back from Here”

You can also start playback by clicking the Play That Back button on the toolbar.

1. To stop playback, click the Stop Playback button on the toolbar, press the
ESC key, or click in the document window.

Since speech input cannot be received during playback, you cannot stop playback
by voice.

Notes
• If dictation is not available, playback skips to the next section that has

dictation available. Recorded speech is not available for text that was
typed or pasted into a document or revised without using the Correction
dialog box; for example, by selecting and saying.

• The Play Back Window, Play Back to Here, and Play Back from Here
commands only play back dictation for text that is in view. For example,
the Play Back from Here command plays back dictation from the cursor to
the bottom of the window.

• You can simultaneously stop playback and open the Correction dialog box
by pressing the minus key (-) on the numeric keypad. The last phrase
played appears in the dialog box for you to correct.

• If the recorded speech for a document exceeds the space available, the
earliest dictation is removed.

• You can use your right mouse button to click in a document, and then
select commands to start and stop dictation playback.

Internet Explorer commands

“Go To Address”
Move the cursor to the Address box. You can then dictate a Web address.

“Go There” “Click Go” or “Go”
Go to a web address you just entered in the Address box.
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“Go To Favorite <name>”
Load the <name> page, where <name> is the name you use for the page in
your Favorites REVISE.

“Refresh” or “Reload”
Refresh the current page from the Web.

“Click <any part of a link or button name>”
Follow the link or click the button.

“Click” is optional. “Click That” “That One” or “Click That One”
Click the link or other object, such as an edit box, pointed to by the arrow.

“Next” “Next Match” or “Next Control”
When multiple links or other objects match a command, select the next match-
ing link or object on the page.

“Previous” “Previous Match” or “Previous Control”
When multiple links or other objects match a command, select the previous
matching link or object on the page.

“Stop Loading”
Interrupt the loading of a Web page.

“Go Back”
Load the previous page (if available) in the browser’s history list.

“Go Forward”
Load the next page (if available) in the browser’s history list.

“Go Home”
Load your Home page.

“Type Text” “Edit Box” “Click Edit Box” “Text Field” or “Click Text Field”
Go to the first location on the page where you can enter text.

“Check Box” or “Click Check Box”
Go to the first check box on the page.

“Image” or “Click Image”
Go to the first image on the page.

“Radio Button” or “Click Radio Button”
Go to the first radio button on the page.

“Page Down” or “Scroll Down”
Scroll the page down by a screen.

“Page Up” or “Scroll Up”
Scroll the page up by a screen.

“Line Down”
Scroll the page down by a few lines of text.

“Line Up”
Scroll the page up by a few lines of text.
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“Go To Top”
Scroll to the top of the current page.

“Go To Bottom”
Scrolls to the bottom of the current page.

“Start Scrolling Down”
Start automatic downward scrolling of the current page.

“Start Scrolling Up”
Start automatic upward scrolling of the current page.

“Stop Scrolling”
Stops automatic scrolling.

“Speed Up”
Increase the rate of automatic scrolling.

“Slow Down”
Decrease the rate of automatic scrolling.

What’s New in 7
Dragon NaturallySpeaking 7 is the fast, easy and accurate way to turn speech into
text. Users can dictate into virtually any Windows-based application at speeds up
to 160 words per minute and achieve higher levels of accuracy than ever before.
Get started in a matter of minutes. Edit documents, control applications and
manage your desktop, all by speaking.

§ More accurate than ever before
Dragon NaturallySpeaking 7 boasts one of the largest accuracy increases of
any Dragon NaturallySpeaking release - up to 15% more accurate than the
previous version. Users can achieve accuracy as high as 99%.

§ Faster than ever before
More than 50 percent improvement in the initialization time of Dragon Natu-
rally Speaking 7 enables “10 seconds to dictation” on baseline systems. Users
can train the software on their voice patterns in just five minutes.

§ Full Support for More Applications
Dragon NaturallySpeaking 7 is compatible with virtually any Windows-based
application, and offers expanded support for the full Microsoft Office Suite
and Corel Word Perfect.

§ Natural Punctuation
Watch as Dragon NaturallySpeaking 7 automatically inserts periods and
commas when you dictate. This feature is ideal for use with casual documents
like e-mails, instant messages and chats.

§ Section 508 Certified
Dragon NaturallySpeaking 7 Professional is the only PC Dictation application
that meets Section 508 standards, established by the U.S. government to make
software accessible for people with disabilities. Dragon NaturallySpeaking 7
Professional Solutions can help people with disabilities achieve maximum
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productivity on PCs, as well as help prevent carpal tunnel syndrome and other
musculoskeletal disorders.

§ Support for Additional Input Devices
You can use Dragon NaturallySpeaking to “talk and dock”: dictate into a
handheld device such as a digital recorder or Pocket PC, then have that record-
ing automatically transcribed when you synch with you PC. Dragon
NaturallySpeaking 7 also supports array microphones and cordless micro-
phones. See the hardware compatibility list for exact model numbers.

§ Vocabulary Optimizer Improves Accuracy
Dragon NaturallySpeaking Version 7 is not only significantly more accurate
right out of the box, but it now includes the Vocabulary Optimizer. The Vo-
cabulary Optimizer can examine your documents for sentence structure and
word use frequency, then adjust the recognition engine to match your writing
patterns.

§ Performance Assistant Optimizes Dragon NaturallySpeaking
Performance
Tell Dragon NaturallySpeaking 7 which applications and usage patterns match
your work habits, and it will automatically configure itself to maximize speed
and efficiency for you.

§ Improved Command Browser
The updated Command Browser provides advanced users more flexibility
when creating and managing custom commands.

§ Improved Text & Graphics Shortcuts
Dragon NaturallySpeaking 7 allows you to insert frequently used blocks of
text and graphics, such as your name, title and signature, into documents with
a simple voice command. These Text and Graphics Shortcuts automatically
match to the font of the document you’re creating.

§ RealSpeak™ Proofing
RealSpeak Proofing is the easiest way to edit your documents. Sit back and
listen as ScanSoft’s RealSpeak V2, the most advanced text-to-speech engine
available, reads your text back to you. You can also have Dragon
NaturallySpeaking 7 read your own recorded dictation back to you as you
review your transcribed text.

§ Network Tools
Dragon NaturallySpeaking 7 comes with a complete set of network tools
designed to facilitate deployment of Dragon NaturallySpeaking throughout an
enterprise. Use the MSI installer to push DNS to client workstations over a
network. Use the new DNS Administration Tools to manage vocabularies and
voice profiles for an entire enterprise from a central location.

§ Improved API functionality
Use the Dragon NaturallySpeaking SDK to achieve any level in application
integration with Dragon NaturallySpeaking 7. From building simple compat-
ibility modules to full embedded functionally, the Dragon NaturallySpeaking
APIs give you the tools you need to speech enable any application.
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Dragon Feature Comparison Matrix
Usability Features

FEATURE PROFESSIONAL PREFERRED STANDARD ESSENTIALS
Microphone included X X X X
Short set-up and user enrollment X X X X
Dictate into most Win-based apps X X X X
Control menus and dialog boxes in most Windows XP & Windows 2000-based applications by voice

X X X X
Simultaneous dictation/command X X X X
Format and edit by voice X X X X
Mouse control by voice X X X X
Nothing But Speech (NBS) X X X X
USB audio support X X X X
Performance Optimizer X X X X
Natural Punctuation X X X
Say Web and browser links by voice X X
Award-Winning RealSpeak 2 X X
Dictation Playback X X
Save audio with text dictation X X
Use with handheld digital recorder X X
Dictate into Pocket PC X X
Third-Party Correction X
Macro Creation Tools
FEATURE PROFESSIONAL PREFERRED STANDARD ESSENTIALS
Text and Graphics shortcuts X X
Macro recorder X
Basic scripting commands X
Advanced MS VBA scripting X
Specialized Application Support
FEATURE PROFESSIONAL PREFERRED STANDARD ESSENTIALS
 Internet Explorer 5, 6 X X X X
AOL 6, 7, 8 X X X X
Word 97, 2000, XP X X X
WordPerfect 10 X X X
Excel 97, 2000, XP X X
Outlook Express 5, 6 X X
Outlook 97, 98, 2000, XP X
PowerPoint 97, 2000, XP X
Create multiple vocabularies X
FEATURE PROFESSIONAL PREFERRED STANDARD ESSENTIALS
Import/export user files X X
Import/export macros X
Import/export vocabularies X
Specialized vocabularies available X
Network tools for push install X
Network tools for vocab mgmnt X
Section 508 Certified X
General Improvements
FEATURE PROFESSIONAL PREFERRED STANDARD ESSENTIALS
15% Accuracy Improvement X X X X
Improved Command browser X X X X
AOL 8 support X X X X
Vocabulary Optimizer X X X X
Add contacts from Outlook Express X X
Improved Dictation Shortcuts X X
Improved RealSpeak X X
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International Radio Codes for Alphabet

A = Alpha N = November

B = Bravo O = Oscar

C = Charlie P = Papa

D = Delta Q = Quebec (pronounced kaybek)

E = Echo R = Romeo

F = Foxtrot S = Sierra

G = Golf T = Tango

H = Hotel U = Uniform

I = India V = Victor

J = Juliet W = Whiskey

K = Kilo (pronounced keelo) X = X-Ray

L = Lima (pronounced leema) Y = Yankee

M = Mike Z = Zulu
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Inspiration 7.0 Educational Edition (95/98/NT/
2000/XP)

Publisher
Inspiration Software Inc.
7412 SW Beaverton Hillsdale Highway
Suite 102
Portland, OR 97225
(800) 877-4292; (503) 297-3004
(503) 297-4676 fax
www.inspiration.com
Educational Cost $69.00

System Requirements
Macintosh

Mac Plus or higher, system 6.0.4 or higher, System 7.x or 8.x; minimum 2 MB
available RAM; hard disk required.

Windows
Compatible with Windows 3.1, Windows 95 or Windows 98; 8 MB RAM,
386,486, or Pentium processor or higher running at 16 MHz or faster; VGA,
SuperVGA, or other Windows 3.1 or Windows 95 compatible graphics card
and monitor.

Description
Inspiration is a powerful visual learning tool that inspires students to organize
their thinking. Students use Inspiration’s Diagram view to dynamically create and
modify concept maps, webs, and other graphical organizers. The integrated Out-
line view enables students to quickly prioritize and rearrange ideas, helping them
create clear, concise writing.

Inspiration helps the user visually develop and organize ideas. Its free-form Dia-
gram view stimulates creativity while helping to reveal new relationships,
thoughts, and perspectives. Toggle to the integrated Outline view to develop ideas
into a written report.

Inspiration makes creating concept maps and webs easy. Concept maps and webs
are powerful visual learning tools. They are visual diagrams that represent rela-
tionships between ideas. Concept maps and webs help organize information and
develop higher level thinking skills, enhancing knowledge and clarity of thought.

Recommended Uses
Inspiration is used across the curriculum in writing classes, literature classes, and in
science, social studies, and math. It also can be used for organizing multimedia
projects; in its most recent version, the outline view can be saved in HTML format.
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Inspiration is especially useful for a visual learner; for some students with learning
disabilities, organizing information using written outline format is very difficult.
By organizing in Inspiration’s graphical mode, students are able to express visual
relationships, which convey the information they want to express. Converting this
visual display to a text-based outline (with perhaps some special notes attached to
some of the graphical items) provides a verbal organizational structure, which
students can then flesh out in writing.

Basic Use
The following activity takes the user through initial steps of creating a visual outline.

Main Idea

type: The Role of Pets
click on: an arrow in the shape tool

type: a source of income
click on: The Role of Pets
click on: an arrow in the shape tool

type: provides company

To Do Rapid Fire

press: select the Rapid Fire tool from the tool bar and click on the text to which
idea boxes will be attached. A red lightening bar will appear. (from the keypad)

type: for children
press: enter

type: for the sick
press: enter

type: for the elderly
press: enter

To Create Different Shapes

click on: provides company

click on a shape from symbol palette

To Delete Links

click on: arrow from Role of Pets to Source of Income
press: delete key

To Draw Links

select: The Role of Pets

position pointer on diamond-shaped handles at the top

click and drag the link to the Source of Income symbol

(to delete link, select it and delete)
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To Edit Diagram or Outline

click and drag items anywhere

Adding Text to Link

Click on the middle of a link; an edit box will appear

type: As mentioned in the news

To Change Text Font and Style

select: text in any box

go to: the FORMAT menu

select: FONT

select: font choice

For Rushwriting

select: any shape

double click: upper left corner rectangle, write notes

To View on One Page

Ctrl E, or from View menu, select Zoom and the Fit to Window;

To See in Outline Format

Ctrl T, or from View menu choose Outline

To Print on One Page

From File menu, select Print Options and select Fit to 1 Page radio button.

Notes

Link to http://www.inspiration.com/book/cm.html. Explore a teaching activity on
concept mapping excerpted from Classroom Ideas Using Inspiration. This book
is full of actual lesson plans created and used by teachers around the country.

JAWS 4.5 for Windows (95/98/2000/XP)

Publisher
Freedom Scientific
Blind/Low Vision Group
11800 31st Court North
St. Petersburg, FL 33716-1805
(800) 336-5658
http://www.hj.com
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Retail Cost: $ 895/1195
(See Notes section for more Purchase Information and Software Maintenance
Agreement information)

System Requirements
To use JAWS for Windows, version 4.5, you need

1. A personal computer that will run the Microsoft Windows 95 operating
system or XP Home for JAWS Standard Edition, or the Microsoft Win-
dows 2000/XP Pro to run JAWS Professional Edition.

2. If Eloquence, the free software synthesizer for JFW software will be used,
a Windows 95/98/2000/XP compatible sound card is necessary. If Elo-
quence is not used, a JFW compatible hardware synthesizer such as the
DECtalk Express is required.

3. 30MB of available hard disk space required.

4. VGA or higher-resolution video adapter (Super VGA 256-color recom-
mended).

As with most systems, the faster the processor and the more memory your com-
puter has the better the performance of your computer and our product.

JFW 4.0 for Windows is a true 32-bit program, and will not work in the Windows
3.1x environment. JAWS supports Microsoft Word under Microsoft Windows 95,
98, ME, NT and 2000. Versions for 95/98 will not work in NT or 2000. However,
the version for NT/2000 will work in any version of Windows except 3.1. When
using Microsoft Windows NT, Service Pack 4 or later is required. For system
requirements for Microsoft Word, refer to the Microsoft Word documentation. For
most complete Web access, MS Internet Explorer (IE) 5.5 should be used.

Description
JAWS for Windows is a screen reader that uses the numeric keypad for its basic
reading functions. A number of interactive hot key commands are available to
change settings easily; these generally are prefixed by the Insert key and then a
letter, number or function key from the alpha side of the keyboard.

There are two particularly strong features in JAWS which help the user: Verbosity
Level and Help.

1. There are three levels of verbal assistance provided to the user: a lot
(beginner), some (intermediate) and little (advanced). The default full
verbosity level is very informative for the new user.

2. The extensive help functions in JAWS for Windows are well developed.
The on-line help for JAWS is rich, and there is included an additional level
of help: context-sensitive help.
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Extensive information about the Windows environment is included with the
JAWS documentation. A developed scripting language also comes with JAWS so
that advanced users may configure JAWS for unique applications or customize an
existing application configuration.

Network Support
JFW is network enabled. For those with multi-user licenses, a single network
enabled copy of JFW can now be installed on a server computer and be run from
multiple computers by a variety of users. This means that any user can go to any
computer on the network, activate and use JFW with his or her personal prefer-
ences preserved.

Note: Network enabling requires a network authorization key.

Windows 2000 Professional Support
One of the changes that Microsoft made in Windows 2000 is in the “Standard
Windows” appearance-setting scheme. When tested it was discovered that with the
new settings JFW would not correctly read icons and graphics labels. However, it
is possible to correct this by changing back to the original settings, which are now
found in the “Windows Classic” scheme. See the note below for details on how to
change this setting.

Note: Select My Computer from the desktop, go to the Control Panel Icon and
press Enter. From the Control Panel, move to Display, press Enter to open, and
then Ctrl Tab to the Appearance tab. Select “Windows Classic” in the Scheme
dialog.

The Run JAWS First feature is now available for Windows NT with service pack
4 as well as in Windows 2000 Professional. This feature is still available in Win-
dows 95 and 98.

Virtual PC Cursor
The Virtual PC cursor was introduced in JAWS for Windows version 3.31. The
intended functionality is to mimic the PC cursor in its ability to navigate and view
HTML documents using the same keystrokes and commands used while working
in a word processing program.

Since there is no cursor or insertion point in an HTML document such as a Web
page or HTML Help window, JAWS for Windows allows visually impaired
computer users to navigate HTML documents as though there is a cursor or
insertion point. This means that editing commands such as selecting, copying, and
pasting text are also available when using the Virtual PC cursor.

The Virtual PC cursor is activated automatically whenever the application focus is
brought into an HTML document such as a Web page or HTML Help window.
Many e-mail programs support the ability to create HTML e-mail messages and
view messages sent in HTML format as well.
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Skip Repeated Text on New Web Pages

Many Web sites contain common text on all of their pages. When this option is
checked, JAWS positions the Virtual PC cursor on the new text of the newly
loaded Web page.

Screen Track Virtual Cursor

When this option is checked, the screen will track the Virtual PC cursor. This is
necessary if MAGic is being used, or if a sighted user needs to follow along
visually. The default is ON.

Say Link Type

There are numerous types of links. When this option is checked, JAWS announces
the link type during Say All and when navigating with the Virtual PC cursor.

Identify “Same Page” Links

Links can point to other places on the currently loaded page. When this option is
checked, JAWS will announce such links as “Same Page links.”

Lines Per Page

This option determines how many lines constitute a page when the Virtual PC
cursor is active. The default value is 24.

Maximum Line Length

This option determines how many characters constitute a line when the Virtual PC
cursor is active. The default value is 150.

Text Block Length

The Move To Next Non-Link Text script uses this option. JAWS will move to the
next block of contiguous characters that are at least the number of the value set
here. The default value is 25. This is how JAWS searches for body text to read.

Graphic Verbosity

This option determines the verbosity in which JAWS speaks non-linked graphics
on Web pages. The choices are No Graphics, Tagged Graphics, and All Graphics.
The default setting is Tagged Graphics.

Graphic Link Verbosity

This option determines the verbosity in which JAWS speaks linked graphics on
Web pages. The choices are: No Graphic Links, Tagged Graphic Links, and All
Graphic Links. The default setting is All Graphic Links.

Image Map Link Verbosity

This option determines the verbosity in which JAWS speaks image map links on
Web pages. The choices are: No Image Map Links, Tagged Image Map Links, and
All Image Map Links. The default setting is All Image Map Links.
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New Frame Indication

This option determines the way in which JAWS indicates the user has moved from
one frame to another on Web pages. The choices are No Indication, Say Frame
Name at Beginning and End, and Say New Frame When Entering. The default
setting is Say Frame Name at Beginning and End.

JAWS Cursor Restriction Feature
The JAWS cursor has 3 separate levels related to where it can move on the com-
puter screen. In previous versions of JAWS the movement of this cursor was
restricted to either the current or parent window with focus when navigational
keys were used.

Now, in addition to the previous restriction options, the JAWS cursor can also be
set to move freely throughout the entire screen area. Each time Insert R is pressed
when the JAWS cursor on, the next level of restriction is spoken and moves the
status to that level.

Application Window Restriction

When the JAWS or Invisible Cursor are within the Parent Window with focus, the
cursor will not move outside the Parent window when using standard navigation
keys such as Page Up Page Down, Home, End, or Arrow keys. This is the default
selection.

Current Window Restriction

When put in this mode, the JAWS or Invisible Cursor are restricted to the current
window that they are in at that moment. This is useful to restrict movement and
reading to a control such as a list box without having to hear other information
outside of that specific control. The cursor will not move outside the Window with
standard navigation keys such as Page Up, Page Down, Home, End, or Arrow
Keys.

Unrestricted

In this new Unrestricted Mode, with the JAWS or invisible cursor active, the user
can freely roam the entire screen regardless of the number of Windows open or
how they appear on the screen. Using this mode, the user can easily browse the
screen line by line and get an understanding of everything available on the screen.

Tables Navigation Support for Many Applications

There are new navigation keys to be used when in a table. These commands read
the contents of the cell, along with the associated row and column headings. The
same keystrokes can be used to navigate tables in Microsoft Access databases,
Excel, Internet Explorer 5, PowerPoint, and Word, and in Corel QuattroPro and
WordPerfect.

Use the following navigational keys when working inside a table, spreadsheet or
database
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Say Cell use Alt Ctrl Num Pad 5.
Reads the row and column coordinates, followed by the cell contents and then
the appropriate row and column headings.

Note: Because of this new function for Alt Ctrl Num Pad 5, the read current
paragraph command has be changed to Ctrl Num Pad 5 is now used to read the
current paragraph.

Next Cell use Alt Ctrl Right Arrow.
Moves the focus to the next cell in the same row and then announces the
column heading followed by cell contents and then the column number.

Prior Cell use Alt Ctrl Left Arrow.
Moves the focus to the previous cell in the same row and then announces the
column heading followed by cell contents and then the column number.

Down Cell use Alt Ctrl Down Arrow.
Moves the focus to the cell below the current cell and reads the row heading
followed by cell contents and then the row number.

Up Cell use Alt Ctrl Up Arrow.
Moves the focus to the cell above the current cell and then announces the row
heading followed by cell contents and then the row number.

Note: For all of these tables keystrokes: in a verbosity setting higher than beginner
the new row number will not be heard.

Note: If there is no cell available in the direction the user is trying to move, JAWS
will state that the bottom or top of column or the end or beginning of a row has
been reached.

First Cell In Table use Alt Ctrl Home.
Moves to first cell in current table and reads row and column coordinates
followed by contents of the cell.

Last Cell In Table use Alt Ctrl End.
Moves to the last cell in current table and reads row and column coordinates
followed by contents of the cell.

Internet Explorer 6.0 Support
JAWS 4.5 continues its ability to read the web with support for Internet Explorer
6.0. Many of the features introduced in Internet Explorer 5.5 continue with identi-
cal key commands and functionality in IE 6.0. Listed below are the major features
that users may be familiar with using.

Screen follows the Virtual PC Cursor
The screen will now scroll to track the location of the Virtual PC cursor.

Persistence of Settings in List of Links
If the user filters or organizes their list in the Link List dialog, this setting will
remain until they change it or exit JFW. The default setting that ships with
JFW is All Links in Tab Order.
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Improvements to Links List
The Links List Dialog status line has been changed. The status line no longer
contains the display filter or the sort order, as these are easily accessible by
tabbing around the dialog. The status line contains the URL for selected link.
This enables the user to determine which of several links with the same text
name they want to activate or move to, i.e., which “Click Here” is the right
one to select

Graphic Announcement Toggle
The user now has the ability to turn off the announcement of graphics that are
not links. The user is able to toggle this through the HTML Settings Dialog in
the Configuration Manager. The choices are: No Graphics, Tagged Graphics,
and All Graphics. The default setting is All Graphics.

ALT Text and Screen Text Toggle
Often, the ALT Text of links on a Web page is different from the text shown on
the screen. Depending on the Web page, either can be more descriptive. The
user now has the choice to select which of these they would like JFW to seek
as the primary text to speak.
If the user selects Screen Text, JFW will use the screen text if it exists, other-
wise, it will use the ALT Text. If neither exists it will use the URL.
If the user selects ALT Text, JFW will always use the ALT Text, if available,
otherwise, it will revert to the screen text. If neither exists it will use the URL.
The user is able to toggle this temporarily through the Verbosity dialog, or
permanently through the HTML Settings dialog in the Configuration Manager.

Word 2000 Support
There are several new Word tools introduced in JFW 4.0. These include Track
Changes and Real Time Spell Check. JAWS 4.5 now provides the ability to enter
the AutoText content and give more feedback when using Word commands.

AutoText Entries

AutoText entries are commonly used entries that Word displays as a Tool Tip
when entering text into a document. To announce the AutoText screen-tips, it is
necessary to turn on the tool tips under the verbosity menu in the Word Configura-
tion Manager.

Tracking Changes to Documents

The Track Changes feature can now be used to announce the revision type and
author when the cursor moves into modified text. It also lets the user know when
the cursor has moved out of modified text; it also is possible to bring up an entire
list of revisions from which to select.

Check Spelling and Grammar As You Type

JAWS now announces a misspelled word or grammatical error as the user is
typing. It also is possible to bring up a list of spelling or grammar errors in the
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document and scroll up or down the list to select and move directly to the one
desired.

Form Fields

JAWS now detects form fields such as text boxes, drop-down menus and check
boxes. JFW will automatically detect the form field prompt if it is to the left or
above but if using the JAWS cursor to locate it, it can be anywhere.

Tables

In addition to the new keystrokes to help navigate in tables and spreadsheets, there
is also the added ability for JFW to detect tables and their row and column titles.

More Verbosity Dialog Support

There are several other options that are now supported by JFW. These options are
selected using the Verbosity dialog. Included are the following

Detect Style Changes
Borders and Pictures Detection
Reading WordArt text tag
Reading Bullets in a list entry
JAWS and Invisible Cursor Context Detection

Screen Sensitive Help Enhancements

Screen Sensitive Help has been adjusted and enhanced to tell the user about
Header/footer pane
The footnote/endnote pane
The comments pane
The document summary
Number of sections and information about the current section
The number of objects in the drawing
Current table cell width and height in points.

Insertion Point Information Announcement

The Insert-F command has been modified. When pressed once it gives font, style,
paragraph and outline information for the character to the right of the insertion
point or for the selected text. When pressed twice, it gives font and style informa-
tion for the insertion pointer, i.e., what the format of new characters typed would
be.

Say Line and Column
Say Line and Column now gets the information from the Object model rather
than the status line so it will work even with no status line visible.

Say Window Prompt And Text

Spelling errors, grammatical errors, fields, form fields, borders, etc. are now
included in addition to the cell content and coordinates when using Insert Tab.
When announcing bordered regions, this keystroke will only announce the border
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and text of the immediate region, unlike the Border keystroke, which will describe
each bordered region, starting from the current one and working outward.

Working in Outline View

Commands are now available to support the promoting and demoting of a heading
to different style levels in Outline View. JFW announces the new level in the PC
cursor mode.

Other Word Enhancements

JFW users can now use several Word advanced features such as Mail Merge and
Proofreading.

Some Toolbar items are now available, including; Data Source Form, Insert Table,
Insert Column, and Insert Microsoft Excel Spreadsheet.

Improved functions in tables include Say Line in table cells when markers or other
symbols are displayed on the screen and Braille will now track in Tables using Alt
Control Arrow keys.

In Beginner Verbosity, JFW will automatically select an item in List Views when
using Backspace or Enter.

More effective searches in document text are now achieved with JFW using Find
Next, because JFW will now read the next occurrence in context.

Find Back and Forward in the Accept or Reject Changes dialog now reads the next
revision and the sentence containing the revision. JFW will also read the selected
revision and context.

The Spellchecker in Word speaks the next error using added JAWS functionality.

Excel

In addition to the new table navigation keystrokes, several other features have
been added to JFW to support Excel.

JAWS now contains keystrokes that will allow you to read only the portion of the
spreadsheet that is visible on the screen. If Title reading is enabled, pressing these
keystrokes will read the appropriate title cells followed by the visible cells’ con-
tents.

INSERT + UP ARROW.
This will allow you to read the visible row.

INSERT+HOME.
This command will the visible row to the current cell.

INSERT+PAGE UP.
This command will read the visible row from the current cell.

INSERT+CTRL+UP ARROW.
This command will read the visible column.
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INSERT+CTRL+HOME.
This command will read the visible column to the current cell.

INSERT+CTRL+PAGE UP.
This command will read the visible column from the current cell.

In addition to the default Read Selected Range, which reads cell coordinates and
all selected cells, users can read the first and last cell by setting the verbosity
setting to “Read First and Last Cell in Selection Only.”

JFW keystroke Insert-F now identifies four kinds of underline styles instead of
just stating if underlining is on or off.

Insert Num Row 5 and Insert F (when the color has been changed from the
default) will now correctly identify the cell’s text color as selected in the Font
Color menu.

Using Ctrl Left and Ctrl Right Arrows while editing a cell (i.e., after pressing
F2) will now correctly read the prior and next word in the cell.

JFW now automatically selects a file listed in the Open or Save As listviews when
JFW is set at Beginner Verbosity.

Screen Sensitive Help in the worksheet has been enhanced to announce the num-
ber of worksheets in the current workbook. Ctrl Page Up or Down and Ctrl Shift S
can be used to move between other sheets.

PowerPoint 2000 Support
With the Internet and the Microsoft PowerPoint 2000 presentation graphics pro-
gram, it is possible to develop and deliver presentations for the Web as well as for
meetings. In PowerPoint 2000, many familiar features have been enhanced to
make presentation development and delivery, online or otherwise, easier.

The main PowerPoint screen, which is called the “Normal View,” is divided into
three panes, each pane serving a different function. This lets the user switch
between a variety of tasks quickly and easily. The first pane is called “Slide View”
and shows the current slide. The next pane, called “Notes Page View,” provides
space for the user to add any personal notes that refer to the slide currently being
shown. The last pane, called “Outline View”, shows the text that appears in the
current slide. As text is added directly into the slide, it automatically appears in the
outline view. Alternatively, any changes made to the text in the outline view are
automatically reflected in the slide view. Pressing the function key F6 toggles
through these panes..

JFW now easily reads OLE charts and objects Excel and other spreadsheets, or
.BMP files from the Paint program. Bring any of these objects into focus from the
top level by tabbing to them and pressing Enter. Go back to the top level by
pressing Esc, at which point it is possible to tab to other objects on the slide.

New functionality has been added that helps the user determine the amount of text
that can easily fit into a particular slide in PowerPoint. JFW does this by alerting



Assistive Computer Technology for Windows Training Manual

35

the user that there has been too much text put into a placeholder. This feature is
called Text Overflow Detection. Screen Sensitive Help will also provide the
information when Insert F1 is pressed. JFW can also announce the approximate
number of lines that are left based on the font size that was used in the last line
typed. This detection is on by default and will help prevent too much information
being put on one slide, which results in the slide looking cluttered.

There is also an Object Overlap Detection feature that has been added as another
Verbosity item. This detects when objects on the slide overlap and is also on by
default.

JFW will now speak the Slides from Files and Custom Animations dialogs in both
PowerPoint 97 and 2000.

In PowerPoint 2000, users can now use cut and paste keystrokes to rearrange
slides in the Slide Sorter View.

A new feature of JAWS 4.0 is the ability to use the virtual cursor to navigate a
PowerPoint slideshow. JAWS uses the virtual cursor to navigate the slide show
after you press F5.

If you are on a bullet point and press either a routing button on the braille display
or you press NUM PAD SLASH to press the left mouse button, the visible pointer
will be routed to the end of the current bullet point. You may then use INSERT+F
to report font information for that bullet point.

A keystroke has been continued in JAWS 4.0 which enables the user to read the
speaker’s notes in normal or Slide Show views: Ctrl Shift N.

JFW now automatically selects a file listed in the Open or Save As listviews when
JFW is set at Beginner Verbosity.

The keystroke Control Shift F is no longer used to toggle Format and Text an-
nouncements. Instead, the user should select the Verbosity dialog using Insert V
and select Format and Text Announcement to On.

When using INSERT+V, the dialog now tells you the state of each item as you
move through the list of application specific settings.

Pressing the F6 key will toggle through each of the three PowerPoint panes in the
“Normal View” (i.e., which are called the “Slide View”, “Notes Page View”, and
“Outline View”).

Microsoft Access
Subforms and main forms are now identified when Tab or Ctrl Tab is used to
navigate them.

When typing text, which is auto-completed, such as when entering text in a
lookup field or macro entry, JFW will now automatically read the completed text.

When adding controls to a form or report with the Select Toolbox Control com-
mand, a label control is now automatically created along with the selected control.
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When listing form controls, JFW now shows the disabled and visible status.

When doing a Backspace or Enter in the Open or Save As listviews in these
dialogs, if a folder or file is not selected, at beginner verbosity, JFW will automati-
cally select an item.

Adobe Acrobat 5.0
PDF documents are designed to preserve the structure and content of a document,
which allows users to share information without concern for alterations to the
original document. JAWS 4.0 now provides functionality to read PDF documents
either through the internet or on the computer using Adobe Acrobat 5.0 or Adobe
Reader 5.0. Reading a PDF document is accomplished using the Virtual PC
Cursor in a manner similar to that of reading the web. However, not all PDF
documents are accessible using JAWS 4.0. It is necessary the author properly
formats a PDF document in order to incorporate the necessary usability features
designed to interface with JAWS 4.0.

Below are the JAWS specific keystrokes for navigating a PDF document
Description Keystroke
Forms Mode ENTER
Virtual Cursor On NUM PAD PLUS
Virtual Find CTRL+F
Links List INSERT+F7
Next Page CTRL+PAGE DOWN
Previous Page CTRL+PAGE UP
Go to Page CTRL+N
Go to First Page CTRL+SHIFT+PAGE UP
Go to Last Page CTRL+SHIFT+PAGE DOWN

JFW 4.0 Support of the MAGic Keyboard
New functionality has been added to allow both MAGic 6.2 and JFW 4.0 to work
together. This is especially helpful for users who use both MAGic and JFW
together for the majority of their computer work.

During installation of MAGic, users are given the option to add the MAGic
Keyboard Layout to JAWS. Then to run the two programs together, MAGic users
simply select to use the JFW 4.0 tracking engine using the Tracking Engine option
on the Preference menu. The next time MAGic is run, JFW automatically begins
speaking. Along with this, the user can select the MAGic Keyboard Layout in
place of the JFW Default or Laptop Keyboard Layout. This setting is found in the
JAWS Options Menu under Basics.

When using the MAGic Keyboard Layout, when a JFW keystroke is used that has
an equivalent in MAGic, the MAGic keystroke takes precedence.

For example, in JFW the keystroke Ctrl Shift C is used by JAWS when in several
popular applications; in Access it is used to create a relationship and in
PowerPoint it is used to read a table, column by column. When the MAGic user
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presses Ctrl Shift C it “Centers the Mouse in View,” or more simply, moves the
mouse pointer to the middle of the active view so that the magnification user can
more easily find it.

Changes in the JFW User Interface

In the Options Menu, Run JAWS From System Tray

This feature removes JAWS from the list of items on the taskbar, which saves time
when Alt Tab is used to move through the list of active programs. JAWS can still
be accessed quickly using Insert J.

Options, Keyboard Addition

If a custom keyboard layout has been created, it will appear along with the tradi-
tional laptop and desktop layouts in the Options Menu, Basics submenu.

Voices Menu

The tab order in the Voice dialogs has been changed to place the Voice pitch after
the selection of the Voice Person.

Help Menu

Quick Reference has been changed to Keyboard Commands to include the key-
board commands that appear on the quick reference cards shipped with JFW, as
well as a comprehensive listing of all the default keystrokes that ship with JFW as
well as many basic Windows keystrokes.

New Configuration Manager Settings
Set Options, Text Processing
Reading Dates

There are new options in the Configuration Manager that allow the user to select
how the date will be spoken. It is now possible to have the option of having
numeric dates spoken.

Reading Dollars

There are new options in the Configuration Manager under Text Processing that
allow the user to select how numbers preceded by a dollar sign are spoken. Check
Speak Dollars to have numbers with the dollar sign in front of them expressed in
dollars and cents. For example: $45.22 would be spoken as, “45 dollars and 22
cents.”

Java Accessibility Bridge
Support For Java Applets And Java Applications Supported by Sun Microsystems
SWING Classes (Via The Java Access Bridge)

JFW provides access to programs supported by the Sun Microsystems Java Acces-
sibility Bridge. This requires the user to install the Bridge as well as Sun’s Java
Virtual Machine. This version of JFW will work with the jdk1.1.8 virtual machine,
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the Java Runtime Environment distributed with jdk1.1.8, the jdk1.2.2 (Java2)
Virtual Machine, the Java Runtime Environment distributed with jdk1.2.2, and the
Java Web browser plug-ins for jdk1.1.8 and jdk1.2.2. No other Java VM is auto-
matically supported in this version of JFW.

When in a Java application, press Ctrl Insert V twice quickly to hear the Java VM
and AccessBridge version information.

JavaScript, a commonly used extension to HTML, is in no way (other than in
name) related to the Java programming language. JavaScript is used by Web
developers to dynamically change the HTML displayed on a Web page. Wherever
possible, JFW reads the changes made by JavaScript to the user.

Many older Java applets and stand-alone applications, probably representing the
majority of those currently available, were written with the AWT classes. JFW 4.0
does not automatically support these programs. Programs written with classes, the
new standard from Sun Microsystems, work the Swing seamlessly with the Acces-
sibility Bridge and are expected to constitute the majority of new Java develop-
ment.

As of this writing, there are over two hundred programs available that are written
with the Swing classes, which automatically speak with JFW 4.0.

Basic Commands

Working with Context Sensitive Help

JAWS has a powerful on-demand Help feature that provides verbal information
and/or instructions for a current task. At any time

1. use Insert F1 to hear screen sensitive help-useful for learning windows.

2. use Insert F1,F1 to bring up application-specific help window in major
applications: e.g., Word.

3. use Insert H to hear JFW hot key commands and/or context-sensitive,
application-specific help.

4. use Insert W to hear Windows keyboard commands.

Working with Keyboard Help Mode

JAWS supports a user-exploration mode. This function, called the Keyboard Help
Mode, is toggled on by Insert-One (from the number row on the alpha portion of
the keyboard). When this function is turned on, all letter keys echo their identity,
and all command sets, e.g., Insert V, do not actually perform a function, but in-
stead are identified and their function described. This mode is toggled off by
entering Insert-One.

New Laptop Keyboard Layout

JAWS 4.0 includes a full Laptop keyboard layout substituting the CAPS LOCK
key in many commands that used to use the ALT key or INSERT. This makes it far



Assistive Computer Technology for Windows Training Manual

39

easier to quickly access all JAWS features - without moving your hands off those
typing keys.

About the JAWS Interface

JAWS uses the numeric keypad as its keyboard base for special reading com-
mands. JAWS now supports three main cursors

1. PC Cursor

2. JAWS Cursor

3. Virtual Cursor

The PC cursor is directly linked to system and application operations as well as
basic keyboard operations. To activate the PC cursor, press Numpad Plus. To
activate the JAWS cursor, press Numpad Minus. Only one can be active at any one
time.

The JAWS cursor is directly linked to the Microsoft Windows mouse pointer. Like
the mouse pointer, it is possible to move around windows with the JAWS cursor
while the PC cursor remains at its current location. Likewise, the JAWS cursor
stays stationary when the PC cursor moves and remains in a fixed location until
activated. As in the case of the mouse pointer the JAWS cursor is not affected
when you type.

It is possible to toggle between the two cursors, and it is also possible to route one
cursor to the other cursor. Insert Minus routes JAWS to the PC cursor. Insert Plus
routes the PC cursor to the JAWS cursor.

The virtual cursor is not visible on the screen but it has been designed to perform
smart automatic reading of areas. Unless turned off, this cursor is automatically on
when working in Internet Explorer. Because of this new virtual cursor, JAWS is
now able to accurately read columnar text on web pages, and can also discriminate
between unrelated text like links and body text.

Interactive reading is also possible by using the standard arrow keys. There are
two types of commands in JAWS: the majority are reading commands issued from
the numeric keypad, but there also are interactive settings commands issued from
the alpha keyboard.

How JAWS Settings are Managed

Basic screen reader settings such as voice pitch and rate, type of keyboard an-
nouncement, etc., are accessible through a menu bar in the JAWS Settings Win-
dow. Use Insert J to bring up the JAWS application window. (Although many
functions available through the menus can be configured by hot key commands.)
There are five menu options

1. Options (use to have JAWS start first, to change from full to laptop key-
board, to exit the JAWS program, or use to change speech rate)

2. Utilities (to access program managers, e.g., Configuration Manager Key-
board Manager, Dictionary Manager, Script Manager-for advanced use)
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3. Language (use to change languages, if installed, or to change synthesizers,
or select “no speech”)

4. Help (This is an excellent source of information about JAWS: keyboard
commands; specialized help for major applications; a “What’s New”
section especially useful when installing and using an upgrade to current
version.)

Refreshing the Screen

Sometimes JAWS does not seem to read properly, and when this is suspected,
refreshing the screen display with the JAWS command Insert Escape will usually
restore normal reading function.

How to Open a Menu

1. Tap the Alt key and then tap the first letter of the menu option. Once the
Alt key has been tapped, it is possible to arrow across through the main
menu options.

2. Move down in the menu with the Down arrow key.

3. Tap the Enter key after hearing the desired topic announced to open its
settings box.

Interactive Hot keys from the Alpha Number Row

Insert-1
Toggles the keyboard help on or off.

Insert-2
Toggles through the keyboard echo function: characters, words, or none.

Insert-3
Use this before entering an application command that is identical to a JAWS
command; JAWS will ignore the command.

Insert-4
Toggles to standard or active graphics mode. Use active graphics mode if
JAWS does not read all tool bar buttons.

Insert-5
Reads color of text at cursor.

Insert-6
Hot key to bring up the Configuration Manager.

Insert-7
An advanced command to work with types of window classes.

Insert-8
Brings up Keyboard Manager, an advanced component. The Keyboard Man-
ager allows you to create application specific key map files.
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Insert-9
Brings up Frame Manager, an advanced component.

Insert-Zero
Brings up JAWS Script Manager, an advanced component.

Interactive Hot Keys from the Alpha Keyboard

Insert B
Read all of dialog box in Tab order. This allows the user to understand what is
in a dialog box before attempting to Tab through its topic area.

Insert C
In some applications will read word in context (e.g., spell check).

Insert D
Brings up Dictionary Manager.

Insert F
Identify font name, size and attribute of text at active cursor.

Control Insert F
Brings up JAWS Find dialog.

Insert H
Context-sensitive hot key application-specific help is verbalized.

Insert E
In a dialog box or special window, announces what button will be selected if
Enter is tapped.

Insert J
Bring JAWS window forward. If JAWS is minimized, this will maximize the
window; if JAWS is open but covered, this will bring the window forward.

Insert R
Restrict action of JAWS cursor. If this is turned on, JAWS will read only in the
active child window. When restriction is toggled off, JAWS cursor can read
anywhere on screen display.

Insert S
Toggle through screen echo settings.

Insert T
Read title bar of window.

Insert V
Brings up Adjust JAWS Verbosity list box. Tapping the Space Bar toggles
through verbosity levels of selected item in list box. Specific verbosity levels
may be set for user verbosity preference, style change detection, context
detection, screen echo, typing echo, say all by, punctuation level, format and
attribute changes speak, graphics verbosity, ANSI character verbosity, braille
verbosity, and mute synthesizer.
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Insert W
Speaks general Windows help.

Insert X
Say frame at cursor; says the text in the frame that the cursor is in.

Insert F4
Unload JAWS.

Insert F6
Minimize all applications on the desktop.

Speech Pad Minus
Turn on JAWS Cursor.

Speech Pad Plus
Turn on PC Cursor. The PC cursor tracks the insertion point or the highlighted
selection cursor.

Insert Up Arrow
Read Current Line.

Up Arrow
Read Prior Line.

Down Arrow
Read Next Line.

Left Arrow
Read Prior Character.
JAWS Cursor Speak Prior Character.
PC Cursor Select prior icon, select prior menu item, or move insertion point
to the prior character.

Right Arrow
Read Next Character.
JAWS Cursor Speak next character.
PC Cursor Select next icon, select next menu item, or move insertion point to
the next character.

Speech Pad 5
Read Current Character.

Insert Left Arrow
Read Prior Word.

Insert Right Arrow
Read Next word.

Insert Speech Pad 5
Read Current Word.

Insert Speech Pad 5
(pressed twice within a half second) Spell Current Word.
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Page Up
Move Up One Screen or to Top of Window.
JAWS Cursor Move to top of active application or child window depending
on the setting for JAWS cursor restriction.
PC Cursor Move insertion point up one screen.

Page Down
Move Down One Screen or to Bottom of Window.
JAWS Cursor Move to bottom of active application or child window depend-
ing on the setting for JAWS cursor restriction.
PC Cursor Move insertion point down one screen.

End
Move to the End.
JAWS Cursor Move to the end of text on the current line or to the last graph-
ics on current line.
PC Cursor Performs the End function for the application. For example, it
could move the insertion point to the end of text on the current line or to the
last item in a list box.

Home
Move to the Beginning.
JAWS Cursor Move to the beginning of text on the line or to the first graph-
ics on the line.
PC Cursor Performs the Home function for the application. For example, it
could move the insertion point to the beginning of text on the current line or to
the first item in a list box.

Insert Home
Speak From the Left Edge of the Window to the Cursor.

Insert Page Up
Speak From the Cursor to the Right Edge of the Window.

Insert End
Read Top Line of Window.

Insert Page Down
Read Bottom Line of Window.

Insert Delete
Speak the Coordinates of the Active Cursor.

Insert Minus
Route (move) the JAWS Cursor to the Location of the PC Cursor.

Insert Plus
Route (move) the PC Cursor to the Location of the JAWS Cursor. This moves
the insertion point or selection cursor to the location of the JAWS cursor and
is equivalent to a single click of the left mouse button.
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Insert Escape
Refresh Screen.

Delete
Delete character at cursor; does not announce character deleted; instead an-
nounces the new character at the cursor.

Alt Delete
Announce active cursor position (in pixels).

Insert Delete
Announce PC cursor position in row and column position.

Alt Insert
Toggle between insert and overwrite editing modes.

Alt Down Arrow
Read dialog prompt.

Insert 3 (from alpha)
Pass next command through to application.

Plus
Invoke PC cursor.

Minus
Invoke JAWS cursor.

Minus (tapped twice)
Invoke invisible cursor from either PC or JAWS Cursor.

Additional Interactive Commands

Insert F11
Say Taskbar.

Insert F12
Say System Tray.

Control Shift H
Say hotkey for current control focus.

Insert Control Down Arrow
Say Help window.

Insert Shift Down Arrow
Say selected text.

Insert Tab
Say window prompt and text.

Insert E
Say default button of dialog box.
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Intermediate Use

How to Hear All Dialog Options in Settings Box

1. Hold down the Insert key and tap the B key. JAWS will announce the
entire contents of the box in the order that the Tab key will take. Current
settings are not announced.

How to Navigate with Tab Key through a Dialog Box

1. Tap the Tab key to navigate forward through options.

2. Shift Tab will navigate backward through options.

3. JAWS will announce each topic box and its current setting.

4. Use the Arrow keys to move up and down within the topic box to hear
other possible settings. Each setting is automatically selected as it is read
and automatically de-selected if the arrow is moved off the selection.

5. Once the right setting for the topic is selected, resume with the Tab key to
move to the next topic box.

6. If a scroll bar is announced in a dialog box, the Right and Left arrows will
move the scroll bar selector point. For example, a scrollbar is used to set
speech rates and volume.

7. A check box can be selected or de-selected by tapping the Spacebar.

8. Use of Insert F1 may bring up additional information about a dialog box
element.

Selecting Text

Use standard Microsoft Word keystrokes to select text
Shift Right Arrow select character
Control Shift Right Arrow select word
Shift End select line
Shift Down Arrow select next line
Example

1. Type one or two sentences so that text appears on two lines.

2. Make sure the PC cursor is active by tapping the Insert Del key to check
status.

3. Move the cursor to the beginning of the first line of text.

4. Hold down the Shift key and tap the End key to select text to end of line.
The text will be read.

5. Still holding down the Shift key, tap the Down arrow key to select the next
line of text. The text will be read.

6. Text can be de-selected by tapping the Slash(/) key on the numeric keypad.
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7. To re-read selected text: Insert Shift Down Arrow

Copying Selected Text to Another Position in a Document

1. Enter Control C to copy selected text to the clipboard.

2. Move the cursor to another position in the open document.

3. Enter Control V to place the copied text.

Deleting Selected Text

Once text has been selected, enter Control X.

Moving Selected Text to Another Position in a Document

When text has been cut, move cursor to new position in document and enter
Control V.

Formatting Text once it has been selected

The following keyboard shortcuts will format selected text
Control B Bold
Control U Underline
Control Shift Z Remove formatting and return text to normal

Advanced Use

How to use the JAWS cursor like a Mouse Pointer

The JAWS cursor can be used like a mouse pointer with the mouse keys that are
described below. To move the Mouse Pointer, use speech pad keys

Slash (/)
Single Left Mouse Click on speech pad. This selects the item at the JAWS
cursor.

Slash (/) Twice in a second
Double Left Mouse Click. This chooses the item at the JAWS cursor.

Insert Slash (/)
Drag an Object on the Desktop. Use the JAWS cursor to point to the object,
press Insert and then Slash (/) to lock the mouse pointer on the object, then use
arrow keys to drag it. Press Insert Slash (/) to release the drag command.

Asterisk
Right Mouse Click on speech pad. Restricting Movement of the JAWS Cursor

Insert R
Turn JAWS Cursor Restriction On or Off.

If several application windows are on the desktop, it is possible for them to over-
lap or totally cover one another. This means that parts of several windows could
be visible around the active application window. The PC cursor stays within the
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active window, which means it will not read information from the surrounding
windows. The JAWS cursor also stays within the active window.

The restriction setting does not affect the movement of the PC cursor. When
restriction is turned on, the JAWS cursor is restricted to the active section of the
screen where it is currently located. If it is in a dialog box when restriction is
turned on, it can only read the active dialog option. When using the JAWS cursor
restriction, in order to ensure that the cursor is being restricted to the proper
section of the desktop, it is best to do the following

1. Route the JAWS cursor to the location of the PC cursor with Insert Minus.

2. Turn on JAWS cursor restriction with Insert R.

How to use the JAWS Configuration Manager

The Configuration Manager contains a Set Options menu. When you choose a Set
Options menu item, a dialog opens. The Configuration Manager includes the
following menu options: User, Text Processing, Window Classes, Graphics and
Symbols, Cursor, Keyboard, Braille, and Advanced. These dialogs enable you to
configure your applications to your own specifications. Use the hotkey Insert
(alpha keyboard) 6, or

1. Press Insert J to activate the JAWS application.

2. Press Alt U to open the Utility menu item.

3. Press C to open to Configuration Manager.

Settings Handled by the Configuration Manager

Use the command for context-sensitive help, Insert F1, when the focus is on an
element in a configuration dialog, JAWS will speak a help message regarding the
nature of the element (e.g., typing interrupt), its function, and its default setting.

User Options

These include typing echo, screen echo, verbosity level, typing interrupt, reading
interrupt, key repeat and Insert key mode.

Text Processing

These include punctuation mode, filter repeat characters, number processing, list
item, mixed case processing, dictionary processing, speak window type first,
speak window state first.

Graphics and Symbols

These include graphic verbosity, ANSI character verbosity, graphic dimensions,
graphics mode toggle.
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Advanced Options
Among these options is found the “go-to-sleep” checkbox. This can be used to
silence JAWS in a particular application. To silence JAWS in a particular applica-
tion, open the application itself, with JAWS running; open the Configuration
Manager and select the go-to-sleep option from the Advanced menu. Save the
change. Now, if JAWS is loaded and this application loads in, JAWS will not
speak in the application at all, but will in all others.

There are other main types of options, but they relate to advanced use.

How to use the JAWS Keyboard Manager

The Keyboard Manager controls the assignment of keystrokes to JAWS activities.
It is important to understand a little about scripts before learning about Keyboard
Manager. All JAWS activities assigned to keystrokes are scripts. A script is a small
computer program that controls how JAWS reacts and what you hear. To open
Keyboard Manager, use Insert (alpha keyboard) 8, or

1. Press Insert J to activate the JAWS application.

2. Press Alt U to open the Utility menu item.

3. Press K to open the Keyboard Manager.

How to use the JAWS Dictionary Manager

This application allows you to alter the JAWS Dictionary. The JAWS Dictionary is
a collection of files that stores all the correctly pronounced words. The Dictionary
Manager is the tool that enables you to manage your own JAWS Dictionary files.
Press Insert D to start the Dictionary Manager and add words to you dictionary.

Use the Dictionary Manager to alter words for specific applications or all your
applications. To save changes changes to all applications, save the changes to the
default.jcf file.

1. Press Insert J to activate the JAWS application.

2. Press Alt U to open the Utility menu item.

3. Press K to open the Keyboard Manager.

How to use the JAWS Frame Manager

You can use Frame Manager to create and work with frames. Frames are bound-
aries on a screen for which you define a JAWS action. Use a frame to define an
area of the window or screen to be spoken automatically.

1. Use a frame to define an area of the window or screen to be spoken when a
keystroke is pressed.

2. Use a frame to define an area of the window or screen for JAWS to ignore.

3. Use a frame to define an area of the window or screen for JAWS to treat
differently than other areas.
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To open Frame Manager, use Insert 9, or

1. Press Insert J to activate the JAWS application window.

2. Press Alt U to open the Utility menu item.

3. Press F to open the Frame Manager.

How to use the JAWS Script Manager (for advanced users)

Small script files are created, edited and compiled with Script Manager. A script is
a small computer program that controls how JAWS reacts and what you hear. For
example, when Insert 5 is pressed, the SayWord script runs. In addition to just
saying the current word, it also checks to see if Insert 5 has been pressed twice, in
which case it spells the word. Groups of scripts are stored in the script files. There
are two basic types of script files: default and application. The default script files
contain those scripts and other things that are always available. Application script
files contain scripts and other things that are only available when a particular
application program is running.

1. Press Insert J to activate the JAWS application.

2. Press Alt U to open the Utility menu item.

3. Press S to open the Script Manager.

Pricing
For extensive information about pricing, site licenses and software maintenance
agreements (SMA), use this web address: www.hj.com/JFW/JFWPricing.html

Installation
Windows NT 4.0 must have Service Pack 4 installed to use MS Active Accessibil-
ity or there will be differences in functionality between the Win 95 and NT ver-
sions in applications that use Active Accessibility, e.g., MS Office.

You must have workstation administrative permissions when installing JFW.
Specifically you must have the permissions necessary to write into the registry.
You must uninstall any product which places entries in the video chain of NT.
Most prevalent of these products are remote control products such as Remotely
Possible, PC Anywhere, etc.

If you are having trouble installing JFW or you are in a blue screen cycle, get to a
point where you can enter a WinMSD from the run on the start menu. The video
chain we are referring to is the list of file(s) in the driver section of the display tab.
Usually the actual driver in use is a DLL at the rightmost position of the chain.
Currently JFW needs to install its driver JFWVID.DLL immediately to the left of
the actual driver. If you find another entry between JFWVID.DLL and the target
driver, JFW will not work.

It is also possible to unload the JFW NT video driver with the following command
from a command line window: c:\jfw\drjaws /setjv=r
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JFW will reset itself when restarted. To reinstall the driver use the following
command: c:\jfw\drjaws /setjv=i

When installing on a dual boot system with NT and some other OS, you must first
install under NT. After installing under NT, you can reboot to Win 95 or Win 98
and reinstall JFW. This will avoid authorization conflicts.

Note that with JFW NT version, the authorization must be on the hard disk and
not on a floppy as is possible with the Win 95 version.

Network

Site license costs: for 5 users, $2,400; for 10 users, $4,000; for 15 users, $6,000;
for 20 users, $6,500. The SMA or Software Maintenance Agreement is ten percent
of the JFW license price and entitles the district to the next two JFW upgrades.

Network Authorization

Now network users of JFW 4.0 with proper authorization can work on any com-
puter in their network as long as the computer is mapped to the drive containing
the authorization key. This feature applies to Windows 95 and 98, Windows NT,
Novell, and Unix servers and stations. For information on obtaining network
authorization, contact Freedom Scientific.

JAWS 4 and Internet Explorer 6.0

Introduction
Internet Explorer 6.0 is a suite of tightly integrated programs that connects a
computer to the information that is available through the Internet and Intranets.
Internet Explorer not only acts as a browser to display the data, but it also helps
the user find, incorporate, and interact with that data. These applications run under
Microsoft Windows 95, Windows 98, and Microsoft Windows NT/2000. When
using Microsoft Windows NT, Service Pack 4 or later is required.

Getting Started
Make sure that IE is installed properly on and running correctly. It is recom-
mended not to install the Active Desktop component with IE. If the IE toolbar is
used, include text labels on the buttons. Default IE settings include text labels.

Open the Internet Explorer settings panel

1. Open the IE Tools menu with Alt T.

2. Tap o to go to Internet Options.

3. Enter Alt E to move to the Accessibility button in this dialog box.

4. Make sure "Ignore Colors..." is selected.
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5. Close this panel by selecting the OK button.

6. Use Control Tab to get to the Advanced settings tab.

7. Under the Accessibility section, make sure the following are checked

8. Always expand ALT text for images

9. Move system caret with focus

10. Under the Browsing section, make sure the following options are NOT
checked
Show Channel bar at startup
Show friendly URLs
Use smooth scrolling
Enable page transitions

JAWS Keystrokes for Internet Explorer 6.0

Support for Internet Explorer 6.0

JAWS for Windows now supports Microsoft Internet Explorer 6.0. All of the
keystrokes you have become accustomed to in Internet Explorer 5.5 remain un-
changed. Use the following commands for navigating in form fields

Ctrl Insert Tab
Move To Next Form Field

Ctrl Insert Shift Tab
Move To Prior Form Field

Ctrl Insert End
Move To Last Form Field

Note: These keystrokes only work in Virtual PC Cursor mode. Once you have
located the desired form field, you need to press Enter to switch to Forms Mode.

Screen follows the Virtual PC Cursor
The screen tracks the location of the Virtual PC cursor.

Persistence of Settings in List of Links
If the user filters or organizes their list in the Link List dialog, this setting will
remain until they change it or exit JFW. The default setting that ships with
JFW is All Links in Tab Order.

Improvements to Links List
The status line contains the URL for selected link. This enables the user to
determine which of several links with the same text name they want to activate
or move to, i.e., which “Click Here” is the right one to select

Graphic Announcement Toggle
The user has the ability to turn off the announcement of graphics that are not
links. The user is able to toggle this through the HTML Settings Dialog in the
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Configuration Manager. The choices are: No Graphics, Tagged Graphics, and
All Graphics. The default setting is All Graphics.

ALT Text and Screen Text Toggle
Often, the ALT Text of links on a Web page is different from the text shown on
the screen. Depending on the Web page, either can be more descriptive. The
user has the choice to select which of these they would like JFW to seek as the
primary text to speak.
If the user selects Screen Text, JFW will use the screen text if it exists, other-
wise, it will use the ALT Text. If neither exists it will use the URL.
If the user selects ALT Text, JFW will always use the ALT Text, if available,
otherwise, it will revert to the screen text. If neither exists it will use the URL.
The user is able to toggle this temporarily through the Verbosity dialog, or
permanently through the HTML Settings dialog in the Configuration Manager.

JAWS Keystrokes for Internet Explorer 6.0

Insert A
AddressBar
Reads the Address bar while maintaining the place on the page.

Insert AA
moves the JAWS cursor to the address bar.

Alt D (an IE 5/6 keystroke)
Selects the text on the Address bar.
Type in a new address, or copy or cut and paste to the clipboard.

Ctrl Insert Home
FocusToFirstField
Moves to the first input field in the page and speaks it. If no form field is
found, JFW reports, “Input Field Not Found.”

Alt Left Arrow or Backspace
GoBack
Loads the previously opened Web page and says the line the user was on prior
to leaving this page.

Alt Right Arrow
GoForward
Loads the next opened Web page and announces it. JFW places the Virtual PC
cursor at the top of the page and says the first line. This is useful when brows-
ing pages.

Ctrl F
IEFind
Calls up the Find dialog.

Tab
MoveToNextLink
Moves to the next hypertext link or control in the page. Activate a link by
tapping Enter.
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Insert Enter
MoveToNonLinkText
Moves to the next block of non-linked text that is larger than 50 characters.
(when using the virtual cursor)

Shift Tab
MoveToPriorLink
Moves to the prior hypertext link or control in the page. Activate the link by
tapping Enter.

Ctrl Tab
NextFrame
Moves to the frame and says the frame label.

Ctrl Shift Tab
PriorFrame
Focuses and reads the previous frame in the HTML order.

Insert Esc
RefreshScreen
Refreshes the screen and updates the state of information of the Off Screen
Model.

Ctrl Insert Down Arrow
ReadCurrentScreen
Reads the body of the page from the top with the JAWS cursor.
Note: This is only available in non-virtual cursor mode.

Ctrl Page Down
ReadNextScreen
Reads the next screen: does a PageDown and begins reading with the JAWS
cursor.
Note: This is only available in non-virtual cursor mode.

Ctrl PageUp
ReadPriorScreen
Reads the prior screen. Does a PAGE UP and begins reading with the JAWS
cursor.
Note: This is only available in non-virtual cursor mode.

Insert F5
ReformatDocument
Reformats multiple column pages to be more readable with speech. Rear-
ranges multiple column pages to read in a linear fashion. IE columns are read
one after another. Note: This is only available in non-virtual cursor mode.

Insert Tab
SaySelectedLink
Says the focused link or control. If in a dialog, speaks the current control. If in
a Web page, announces the link or control with focus.
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Insert F9
SelectAFrame
Brings up a dialog containing a list of the frames present in the page. Select a
frame from the list and press Enter. The focus moves to the frame selected and
speaks its content.

Insert F7
SelectALink
Brings up a JFW dialog containing all of the links present on the page. Select a
link by using the Arrow keys or the first letter of the link. Press Enter to open
the selected link. TAB between the various controls in the Select A Link
dialog.

Insert F8
IE Tool Bar access
Allows access to the IE toolbar. While in IE, brings up a dialog box that
contains a list of every button that appears on the toolbar. In this dialog, select
one of the buttons on the toolbar and press Enter to choose it.

Insert Z
VirtualPCCursorToggle
Toggles the Virtual PC cursor mode On or Off. When in a web document, this
command toggles between the Conventional mode and the Virtual PC cursor
interface.

Helpful Hints
When working in Internet Explorer 6.0 with JFW, the user works in one of three
modes: Virtual PC cursor mode, Forms mode, or Conventional mode.

It is not possible to use the Context Detection (Insert F) option when using the
virtual cursor.

Virtual PC Cursor Mode

The Virtual PC cursor is activated automatically when IE 6.0 opens, and JFW
begins speaking the text on the screen as soon as the page finishes loading. If the
newly opened page is loaded, JAWS announces the presence of frames, links, and
forms on the page. JAWS will announce if there are no frames, links, or forms on
the page.

The Virtual PC cursor works in the Internet Explorer 6.0 environment in much the
same way that the PC cursor does in other applications. The Virtual PC cursor
responds to normal screen reading keys in the same way, but there is no visual
indication on the area of the screen that is being read. In addition, the screen does
not automatically scroll, so to bring up text that is out of screen range, use Insert
Esc.

Caution: Manually starting to read before the loading has finished often results in
less than all of the text being available.
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When reading a Web page with the Virtual PC cursor, select text using the stan-
dard Windows text selection keys (e.g., Shift Right Arrow to select a character;
Control Shift Right Arrow) to select word ; there is no visual feedback of what is
being selected. The SaySelectedText script (Insert Shift F2) speaks the text that
has been selected.

When a page with frames first comes up, all frames are readable in sequential
order. Check with Insert F1 and JAWS announces: “The page contains frames.”

As the user enters a frame, JAWS says its name, e.g., “Navigation Frame,” JAWS
announces the frame name and "end" when the user leaves a frame.

Ctrl Home brings the top of the document into view on the visual screen, Ctrl End
brings the bottom of the document into view on the visual screen, PageDown
moves down 24 lines, and PageUp moves up 24 lines. SayAll (Insert 2 on
numpad) in line mode reads the document from top to bottom. To stop this read-
ing, tap Ctrl to stop the SayAll function. JAWS positions the cursor near the last
item read.

When reading text on a Web page, each link appears to be on its own line, even
though this may not be true on the screen. Visited links are identified as “visited.”
They are also properly categorized as visited in the Links List dialog. Note: When
JAWS reads "strange things," the following is probably occurring: when JFW
encounters a link that does not have any text associated with it, one of two things
is announced. If the link is a CGI link, the name of the graphic is spoken. Other-
wise, the last directory component and the file name of the URL is spoken instead.

To quickly skip past headers, press Insert Enter. This moves the user down through
the page to the first text of at least 50 characters that is not a link. When it arrives
at the text, the current line is read.

When the cursor is on a line with a link, pressing Enter or Numpad Slash activates
that link. Subsequently, pressing Backspace moves back to the last position on the
last page read.

When using the virtual cursor and a link on the screen that has an ALT tag is
encountered; JAWS will read the ALT tag.

How to Turn Virtual Cursor On and Off

It is not possible to use the reformat option (Insert F5) in Internet Explorer (IE)
when the virtual cursor is in use. Therefore, if the user wishes to work in the web
environment using the JAWS interface of version 3.30, which allows reformatting
of web pages, it is necessary to turn off the virtual cursor.

1. With Internet Explorer open, enter Insert 6. The configuration file for IE,
browseui.jcf, is opened by the Configuration Manager. (To make this
change throughout all applications, load the default configuration file from
the Configuration Manager file menu and then do the following.)

2. Enter Alt S to open the Set Options menu.

3. Tap a for Advanced Options.



Assistive Computer Technology for Windows Training Manual

56

4. Enter Alt V to toggle the virtual cursor state off.

5. Save the browseui.jcf file by entering Ctrl S.

6. Close the Configuration Manager with Alt F4.

Note: To toggle between Virtual PC cursor and PC cursor, press Insert Z.

Forms Mode

With the Virtual PC cursor positioned on a form field, press Enter (not Num Pad
Slash) key to switch to Forms Mode. JAWS will announce "Forms Mode On," and
speak the name of the control which has cursor focus. At this juncture, tap Enter to
activate the PC cursor at the current control.

Possible example: If the user is on a button, the button is pressed. If the user is on
a checkbox, the state of the checkbox is toggled. If on a radio button that is un-
checked, then the radio button is checked; however, if it was already checked, it
remains unchanged. In an edit box, the PC cursor is placed at the top of the edit
field. In a combo box, the first item is selected.

Tab and Shift Tab must be used to move between fields in forms mode. When
using these keys for navigation, the natural tab order is used, including any links
that may appear between fields. As JAWS lands on the different controls, it an-
nounces the new control, such as a link or a field.

While in forms mode it is possible to edit fields using the PC cursor as done
normally.

To exit Forms Mode, press Num Pad Plus to return to the Virtual PC cursor.

Note: JFW remains in Forms Mode until the virtual PC cursor is activated or a
new page is displayed, whichever comes first. Insert Esc also returns the user to
virtual cursor mode and moves the position of the virtual PC cursor to the first
control on the current page.

Tip: Return to the Virtual PC cursor using the NumPad Plus. This turns Forms
Mode off.

Link List Dialog

When in IE 6.0, bring up the Link List dialog by pressing Insert F7. This brings up
the Links List view. By default this list is sorted in tab order and shows all links.
This List view lists the links on the current page according to the filter and sort
order set by the other controls in this dialog. Each time it comes up, it defaults to
listing all links in tab order. If the links have the same name but point to different
locations, each one is listed in this list view.

Visited links are determined by what IE indicates as a visited link. If IE keeps in
memory what links have been visited in the (for example) last 10 days, a link will
display as visited until the 10 days are up. It is possible for the user to adjust the
time IE keeps links as visited.



Assistive Computer Technology for Windows Training Manual

57

The Links List dialog has a display area where in the lower portion of the dialog
box. Three radio buttons affecting link display are placed there

All Links, which if selected shows all links.

Visited Links Only, which if selected shows visited links.

Unvisited Links, which if selected shows unvisited links.

The Links List dialog has radio buttons which allow the user to set the way the
Links List dialog box displays links. In Tab Order, which if selected, lists the links
in tab order; and Alphabetically, which if selected lists the link alphabetically.

There are also three buttons which assist the user in navigating: Move To Link
which if selected moves to a link; and Activate Link which if selected moves to an
activated link; and Cancel, which if selected closes the Links List dialog.

Alt M
Move to Link button
When activated, closes the dialog box and moves the Virtual PC cursor to that
link on the current Web page. Use the navigational keys to explore around the
link.

Enter
Activate Link button
Closes the Link List dialog box and activates the selected link. It is also the
default button.

The Display group box allows the user to select the radio button to filter the
displayed list to display all links (default), visited links only, or unvisited links. t is
possible to tab to this group box or use hot keys to change the settings without
leaving the list view. Hot keys to change the link display are as follows

ALT L
Display All Links

ALT V
Display Visited Links Only

ALT U
Display Unvisited Links

The links list can have the links appear in or alphabetically. Tab to this group box
or use hot keys to change the settings without leaving the list view. Hot keys are as
follows

ALT T
Display links in tab order (default)

ALT P
Display links in alphabetical order

In the Links List dialog it is possible to close the dialog box and return to current
position on a web page by activating the Cancel button with Alt C or tapping Esc.
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Working in Conventional Mode (as in IE 4.01)

Note: To temporarily toggle between Virtual PC cursor and PC cursor, press Insert Z.

By turning off the Virtual Cursor, it is possible to navigate in IE using the JAWS cursor
and reformatting options that were used by JFW in IE 4.01. This functionality is not
available if the Virtual PC cursor mode is enabled. To find out more about how the
JAWS conventional mode works, as in IE 4.01, see the JFW Help topic "Using JAWS
with Popular Applications" section on using JAWS with IE 4.01.

Web Based Activities to Learn to Use JAWS
The High Tech Center Training Unit has developed a series of web pages designed
to be used with JAWS: www.htctu.net/readweb/readweb

The following text accompanies these activities

Reading Web Pages with JAWS 4.5

The California community colleges Distance Education Access Guidelines for
Students with Disabilities require that all web-based instructional resources be
WAI Priority 1 compliant. A large number of Priority 1 guidelines address access
considerations for persons who are blind.

Additions to JAWS version 3.7 greatly improved the capacity of this screen reader
navigate more complex web pages. These features were carried over into the new
version of JAWS 4.0 and have been extended in JAWS 4.5. The web pages pro-
vide examples of the types of web page formats which can now be read with
JAWS and the JAWS keystroke commands for reading them.

These example pages are meant to be explored using Microsoft Internet Explorer
6.0 and JAWS version 4.5. JAWS makes extensive use of the "accessibility hooks"
built into Internet Explorer 6.0 and will not provide the same level of access when
used with Netscape Navigator or earlier versions of Internet Explorer. Please
remember that pressing the Ctrl key will stop JAWS reading, pressing the Tab key
will move to the next link and pressing Shift Tab will move to the previous link.

These activities illustrate how the power of the new Virtual Cursor has increased
the capability of JAWS to read complex web pages.

Important: JAWS reading commands use the Num Pad keys.

Reading Web Pages with JAWS 4.5 - Internet Explorer 6.0

Reading Letters and Words

Read next character
Right arrow

Read previous character
Left arrow

Read current character
Num Pad 5
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Read next word
Insert Right Arrow

Read previous word
Insert Left Arrow

Read current word
Insert Num Pad 5

Reading Lines and Sentences

Read next line
Down Arrow

Read prior line
Up Arrow

Read current line
Insert Up Arrow

Read next sentence
Alt Down Arrow

Read prior sentence
Alt Up Arrow

Read current sentence
Alt Num Pad 5

Reading Paragraphs and Pages

Read next paragraph
Ctrl Down Arrow

Read prior paragraph
Ctrl Up Arrow

Read current paragraph
Ctrl Num Pad 5

Move to top of page
Ctrl Home

Move to bottom of page
Ctrl End

Read to end of page
Insert Down Arrow

Reading Web Page Tables with JAWS 4.5

Reads the row and column coordinates, followed by the cell contents and then the
appropriate row and column headings.

Ctrl Alt Num Pad 5
Press Alt after Ctrl and release Alt before Ctrl
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Moves to the next cell in the same row and then announces the column heading
followed by cell contents and then the column number.

Ctrl Alt Right Arrow
Moves to the previous cell in the same row and then announces the column head-
ing followed by cell contents and then the column number.

Ctrl Alt Left Arrow
Moves to the cell below the current cell and reads the row heading followed by
cell contents and then the row number.

Ctrl Alt Down Arrow
Moves to the cell above the current cell and then announces the row heading
followed by cell contents and then the row number.

Ctrl Alt Up Arrow
Moves to first cell in current table and reads row and column coordinates followed
by contents of the cell.

Ctrl Alt Home
Moves to the last cell in current table and reads row and column coordinates
followed by contents of the cell.

Ctrl Alt End

Using JAWS 4.5 to Read Forms

Moves to the first input field in the page and speaks it. If no form field is found,
JAWS reports, “Input Field Not Found.”

Ctrl Insert Home
With the Virtual PC cursor positioned on a form field, enters Forms Mode and
speaks the name of the control which has cursor focus. Press Enter to activate the
PC cursor at the current control

Enter
To move to next field in forms mode. When using these keys for navigation, the
natural tab order is used, including any links that may appear between fields. As JAWS
lands on the different controls, it announces the new control, such as a link or a field.

Ctrl Insert Tab
To move to previous field in Forms Mode

Ctrl Insert Shift Tab
To move to last form field

Ctrl Insert End
To exit Forms Mode and return to the Virtual PC cursor

Num Pad Plus

Reading frames with JAWS 4.5

JAWS 3.7 was capable of identifying the presence of frames on a web page and
moving to the location of each frame. This is maintained in JAWS 4.5. Use nor-
mal JAWS web keystrokes for reading the content of the frame.
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Announce the presence of frames on the page
Insert F1

Bring up a dialog box containing a list of the frames present on the page. Use the
Up/Down arrow keys to select a frame from the list and press ENTER. The focus
will move to the frame selected and speak its content.

Insert F9
Move to next frame

Ctrl Tab
Move to previous frame

Shift Ctrl Tab

Reformatting web pages with JAWS 4.5

Complex web pages can be automatically reformatted for better screen reader
access.  Press Insert z to turn off the Virtual PC cursor then press Insert F5 to
reformat the screen.

Display all page links with JAWS 4.5

For a quick display of all links on the active web page in their tab order, press
Insert F7

Use the Up and Down Arrow keys to navigate the list and hear the link names

Use the Enter key to go to a selected link.

Basic Web Navigation

JAWS and Internet Explorer 6 provide a variety of ways to perform basic web
page navigation. The following keystrokes outline some of these basic functions.

Move to and read address bar
Insert a

Move JAWS cursor to address bar
Insert a a (quickly)

Select address bar
Alt d

Search page content
Ctrl Insert f

Next web page
Alt Right Arrow

Previous web page
Alt Left Arrow
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JAWS 4.0 with Word 2000
JAWS now has a richly functional interface as it operates in Word. It is possible to
read by larger linguistic units (sentence or paragraph) when working in a Word
document or other extended text reading environments (e.g., an Internet page
being read with the JAWS cursor).

Excellent Word training tapes and disk activities for the intermediate user have
been developed by Henter-Joyce and are available at:

http://www.freedomscientific.com/fs_products/tutorials_word.asp

The cost of the tutorial is $79.95.

Traditionally, a JAWS with Word 2000 training at the High Tech Center Training
Unit includes working with materials and exercises developed by the federally
funded Project ASSIST with Windows. The Iowa State Department for the Blind
is responsible for developing these materials. Information about these materials
(download available for $25.00) can be obtained from the following website

http://www.blind.state.ia.us/Assist/default.htm

Helpful Hints
Toolbars are now easily accessed in Microsoft Word. Use Alt to activate the menu
bar. You can then use Control Tab to move from control bar to control bar and use
the Arrow or Tab keys to move from button to button within each command bar.

The Office Assistant can be a very useful tool in Microsoft Word. It does however
frequently cover useful information. If you find that text seems to disappear or
parts of windows seem to be covered; the Office Assistant may be on top of the
active window. In many cases it is preferable to disable most of Office Assistant’s
capabilities. To do this, move to the Office Assistant button (Microsoft Word Help
button) in the Standard Toolbar or from the Help Menu. Press Enter to activate the
Office Assistant. Tab to the Options button and press Enter. This will bring up the
Office Assistant multi-page dialog. On the Options page, turn off the undesired
options.

Introduction
JAWS 4.5 works in Word 97, 98 and 2000/XP. Specific information detailing the
new features and keystrokes can be found in the JAWS Help Menu under the topic
heading “What’s New?”. For the purposes of the rest of this training guide, em-
phasis will be placed on those functions most commonly used in beginning and
intermediate word processing tasks

Style Changes
Field Detection
Comment, Footnote and Endnote detection
Table Detection
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Table Title Reading
Set Row Titles Column
Set Column titles row
Clear Title Definitions
Borders and Pictures
Language Detection
Page Breaks and Tab Position
Detect Context with JAWS/Invisible Cursor

Style Changes: Detects and announces document style changes when navigating a
document. Document styles are set from the Format Menu, Styles option. Use Ctrl
Shift S to set styles from the Style section of the toolbar.

Field Detection: Detects and announces fields when navigating a document;
fields include Form Fields and Toolbox controls as well as all others.

Comment, Footnote, and Endnote detection: The user can now have JAWS
detect and automatically read footnotes, endnotes and comments without moving
the cursor from the reference point in the document. It is also possible to bring up
a list of the Comments and move the cursor to the portion of text relating to the
selected comment. To reread the comment referenced at the cursor use Alt Shift
Apostrophe, and to list all comments and focus on the text relating to the selected
comment use Ctrl Shift Apostrophe. To reread the referenced footnote or endnote
use Alt Shift T.

Table Detection: JAWS can detect when the user moves into, out of, and within a
table (from row to row or column to column) and delivers an alert when tabbing
into the last cell. This detection has been enhanced to also detect nested tables.
Use Ctrl Shift T to list all tables in the document and be placed in the first cell (or
form field if the document is protected) of the selected table. The list shows each
table and its dimensions, and special JAWS keystrokes have been created to make
table reading an easier task.

Table Title Reading: Allows the setting up and automatic reading of row/column
titles in a table, even when not visible. The settings

Read No Titles (default)
Read Column Titles
Read Row Titles and Read Both Titles

Use the Adjust JAWS Verbosity Dialog options for setting the row and column to
be used for titles.

To re-read a column title use Alt Shift C and to re-read a row title use Alt Shift R.
It is not possible to read column titles if a table is non-uniform; i.e., rows have
different numbers of columns.

Note: There are alternative modes for some tasks: Read the current table row by
using Ctrl Shift R or the current table column by using Ctrl Shift C. Navigate
tables using the new default JAWS Table Reading keystrokes. When working in a
protected file, the reading table row or column functions may not work.
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Set Row Titles Column: This allows the user to choose the column where row
titles are stored. If not set, JAWS assumes column 1.

Set Column titles row: This allows the user to specify which row contains col-
umn titles. If not specified, JAWS assumes row 1.

Clear Title Definitions: This resets the row and column title definitions to the
default and turns off title reading.

Borders and Pictures: JAWS can now detect borders around text, paragraphs and
sections and can describe the border's line style, thickness, color and art style

Alt Shift B
Describes the border around the text containing the cursor. JAWS will also
detect inline objects. These are objects in the text layer. Usually objects such
as Word Art objects reside in the Drawing layer. This means they can be
anchored to a point but may appear anywhere on the page. Such objects can be
converted to inline objects; i.e. placed inline in the text so they can be detected
while navigating. It also is possible to convert Word Art objects to inline
objects and thus have JAWS read the Alternative Text tag (Word 2000).

Alt Ctrl Shift C
Converts all Drawing Layer objects to Text Layer objects. It is possible to list
all inline objects in a document and place the caret adjacent to the chosen
object by using Ctrl Shift O.

Language Detection: This new feature means that when navigating or reading
text in a document containing multiple languages, and if using Eloquence, JAWS
will automatically switch languages appropriately. If not using Eloquence then the
synthesizer in use alerts the user to the language change by speaking the language
name in the Message Voice before the text in that language. SayLine, SaySentence
and SayParagraph all honor Language switching. Henter-Joyce advises having all
needed language modules installed for Word before using this feature.

Page Breaks and Tab Position: JAWS can now automatically speak a new tab
position in the default unit of measure as well as announce when a page break is
tabbed over. JAWS announces the distance from the left edge of the page to new
cursor position. When arrowing or performing a page down (or up) and page
boundaries are crossed, JAWS announces the page number of the new page. The
SayCursorPosition script Alt Delete also announces the distance from the left and
top edges of a page in the default unit of measure used by Word (PC Cursor only).

Detect Context with JAWS/Invisible Cursor: The detection of all of the above
works with the PC cursor; adjust this verbosity setting to allow the detection to
work with the JAWS or Invisible cursors (Word 2000 only).

JAWS Commands Organized by Topic

Reading and Navigation Commands for Word

Using the Say All Command



Assistive Computer Technology for Windows Training Manual

65

• Insert Numpad 2
Read to End of File
With the PC cursor active, JAWS will read to the end of a file with this com-
mand. A very handy feature has been added to JAWS that allows the user to
move rapidly through text being read by the Say All command. Tapping the
Shift key as JAWS reads will cause JAWS to immediate move to either the
next line, sentence or paragraph. This allows for rapid review of text. Using
Shift Tab moves JAWS up to the previous item.

To set JAWS to read by line, sentence, or paragraph at the Say All level, go to the
Text Processing dialog box in the configuration manager and select the desired
radio button. The choice to have JAWS announce blank lines is also included in
this section. To make any changes permanent in Word, save the change to the
winword.jcf file.

Sentence and Paragraph Reading

• Alt Numpad Plus
Say Sentence
Reads the current sentence. Reads the sentence in which the PC cursor is
positioned.

• Alt Up Arrow (from expanded key set)
Say Prior Sentence
Moves the PC cursor to the beginning of the previous sentence and reads it.

• Alt Down Arrow (from expanded key set)
Say Next Sentence
Moves the PC cursor to the beginning of the next sentence and reads it.

• Control NumPad 5
Say Paragraph
Reads the current paragraph. Reads the paragraph where the PC cursor is.

• Control Up Arrow (from expanded key set)
Say Previous Paragraph
Moves the PC cursor to the beginning of the previous paragraph and reads it.
(Repeat the command if cursor falls on blank line between paragraphs.)

• Control Down Arrow (from expanded key set)
Say Next Paragraph
Moves the PC cursor to the beginning of the next paragraph and reads it.
(Repeat the command if cursor falls on blank line between paragraphs.)

• Insert F8
List Hyperlinks
Provides a list of hyperlinks for the entire document as well as the ability to go
to a link.

• Ctrl PageDown
Next Page
Moves to the top of the next page and speaks the current line.

• Alt Delete
Say Cursor Position
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Reports the distance from the left and top edges of the page in the default
unit of measure when the PC cursor is active in the current document win-
dow. The page number is also included as part of the description.

• Insert Delete
Say Line And Column
Announces the line and column that is located in the status line.

• Control F6
Switch Document Panes
This command always been available to toggle through open documents but
now JAWS will announce the new pane.

Other Useful Commands

• Control Insert F4
Close Office Assistant
Closes the Office Assistant. Use this command when the Office Assistant
window obscures useful information.

• Control Insert V
Say Word Version
Announces version of Word that is running.

• Insert Delete
Say Line and Column
Announces the line and column position of PC cursor on document page.
Note that this does not reference cursor position on screen, although it may
coincide with it. This reads line and column numbers displayed in status line.

• Insert Tab
Say Window Prompt And Text
Says the current focus of system cursor (e.g., menu option, current radio
button, or current list box and selected content.) In Word 97 it can announce
the position and content of the current cell in a table.

Commands Useful For Formatting

• Control Shift F
Font Dialog
When no Format Toolbar is present, the Font Dialog box is called up by this
command. Font type, font style (e.g., bold or italic), and point size can be set
through this dialog box. These selections will affect any text that is selected,
or entered from the PC cursor point forward.

• Insert F
Announce Font Information
Performing this command once causes JAWS to announce full paragraph
formatting, as well as insertion point formatting, including line spacing, list
information, font color if different from default. Holding down the Insert key
and tapping F twice quickly causes JAWS to announce insertion point for-
matting and font information only.

• Control Shift P
Point Size
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When the Format Toolbar is present, the PC cursor is moved up to the Font
Size list box on the tool bar. Using the arrow keys will move through available
font sizes. Press Enter to set size and return to document.
When no Format Toolbar is present, the Font Dialog box is called up by this
command and the PC cursor focus is in the size edit box. Use the Arrow keys
to move up or down through available point sizes.

• Control Shift S
Style
Moves to the Style combo box on the toolbar.

• Alt Shift Right Arrow
Select Next Heading Style
Moves forward through the heading style in the Style drop-down list.

• Alt Shift Left Arrow
Select Prior Heading Style
Moves up through the list of heading styles in the Style drop-down list.

• Control L
Left Justify
Aligns text that is selected or entered. This action uses the Word command to
left justify the text. The left margin is even or aligned. Use Insert F to confirm
the setting.

• Control E
Center Text
Positions any selected text so that the left and right margins are equal. Used,
for example, to center an essay title. Aligns text to the center that is selected or
entered. This action is using the Word command to center text. Use Insert F to
confirm the setting.

• Control R
Right Justify
Right aligns text that is selected or entered. Uses the Word command to per-
form this function. Use Insert F to confirm the setting.

• Control J
Justify Text
Using the Word command to justify text, the text is made even along both the
left and right margins. Use Insert F to confirm the setting.

• Control Alt I
Toggle Writing Mode
Toggles between typing and overwrite mode.

• Control B
Bold Text
Bolds text that is selected or entered. Use Insert F to confirm the setting.

• Control I
Italic Text
Italicizes text that is selected or entered. Use Insert F to confirm the setting.
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• Control U
Underline Text
Underlines text that is selected or entered. Use Insert F to confirm the setting.

• Control Delete
Delete Word
Delete the current word and speak the word the PC cursor lands on.

Additional Information
Bullet Announcement: When navigating through bulleted lists, JAWS will
now announce when a bullet appears and the text on the current line, regard-
less of the bullet type.

Selecting Text
Holding down the Shift key in combination with other keys will select differ-
ent items

• Shift Right Arrow
Select a Character

• Shift Left Arrow
Select Previous Character

• Shift Control Right Arrow
Select Current Word

• Shift Control Left Arrow
Select Previous Word

• Shift End
Select from Cursor to End of Line

• Shift Home
Select from Cursor to Beginning of Line

• Shift Insert Numpad 2
Read Selected Text

Reading Multiple Lines of Selected Text

Below is one way to select two lines of text and read them before deciding to
delete, move or copy the text.

1. Type one or two sentences so that text appears on two lines.

2. Make sure the PC cursor is active by tapping the Insert Del key to check
status.

3. Move the cursor to the beginning of the first line of text.

4. Hold down the Shift key and tap the End key to select text to end of line.
The text will be read.

5. Still holding down the Shift key, tap the Down arrow key to select the next
line of text. The text will be read.

6. Text can be de-selected by tapping the Slash(/) key on the numeric keypad.
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Copying Selected Text to Another Position in a Document

1. Enter Control C to copy selected text to the clipboard.

2. Move the cursor to another position in the open document.

3. Enter Control V to place the copied text.

Deleting Selected Text
Once text has been selected, enter Control X.

Moving Selected Text to Another Position in a Document
When text has been cut with Control X, move cursor to new position in docu-
ment and enter Control V.

Formatting Text after it has been selected

The following keyboard shortcuts will format selected text

Control B
Bold

Control U
Underline

Control Shift Z
Remove formatting and return text to normal

Extended Text Selection (F8)

Use F8 to turn on Extended Selection mode in Word. Subsequent presses of F8 do
the following
F8 2 times Selects word at cursor position
F8 3 times Selects sentence at cursor position
F8 4 times Selects paragraph at cursor position
F8 5 times Selects entire document
JAWS will announce the unit being selected and the text of that unit. Other navi-
gational keys can be used to extend the selection as well. To turn off Extended
Selection, tap Escape.

Using the Spell Check and Grammar Functions
JAWS 4.0 comes with much more support for Word Tools. Numerous additions
are available in the spell check/grammar function.

Insert F7
Read Mistake and Suggestion
Reads and spells the misspelled word and the first suggestion in the spelling
dialog.

Insert C
Read Word in Context
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Reads entire document line in which the highlighted word in spellcheck box
appears.

Ctrl Shift E
List Spelling Errors
Brings up a list of spelling errors.

Ctrl Shift G
List Grammatical Errors
If Check Grammar while Typing is on, this feature lists the grammatical errors
within a document.

Spelling Error/Grammatical Error Detection

JAWS can automatically detect and report spelling and grammatical errors as well
as announce how many errors are on the current line. In the list of grammar errors
or spelling errors, it is possible to move the cursor to a specific error. In order for
these Tools support utilities to work it is necessary to enable the following

“Check Spelling as you Type and/or Check Grammar as you Type”.

When Check Spelling as you Type is enabled, JAWS speaks "misspelled word"
when the cursor moves to a misspelled word.

If Check Grammar as you Type is enabled then JAWS announces "grammar error"
when you move into and out of the text marked as a grammatical error.

When either of these features is enabled, then arrowing onto a line or doing a Say
Line on a line with errors will read the line followed by announcing the number of
errors (by saying X errors on line).

Commands for Use in Outline Mode
JAWS can now works in Outline View in Word.

Tab or Alt Shift Right Arrow (PC cursor active)
Promote paragraphs

Shift Tab or Alt Shift Left Arrow (PC cursor active)
Demote paragraphs

Alt Shift A
Toggle text display

Alt Shift 1
Display Heading 1

Alt Shift 2
Show two heading levels

Alt Shift 3
Show three heading levels

Alt Shift 4
Show four heading levels
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Alt Shift 5
Show five heading levels

Alt Shift 6
Show six heading levels

Alt Shift 7
Show seven heading levels

Find Functions
When prefaced with the Microsoft Word Find command (Ctrl F) the following
commands perform these actions

Control PageUp
Top of Screen
Performs a Find Prior. If an initial find has not been performed, then moves
the cursor to the top of the screen.

Control PageDown
Bottom of Screen
Performs a Find Next. If an initial find has not been performed, then moves
the cursor to the bottom of the screen.

Control Insert Right Arrow
Find Next Highlight
Moves to and speaks the next highlight after the cursor.

Table Functions
Alt 1

Say First Cell in Column
Speaks the content of the first cell in the current column. Reads the content of
the first cell in the current column, which is often the header of the column.

Alt 7
Say First Cell in Row
Speaks the content of the first cell in the current row. Reads the content of the
first cell in the current row, which is often the name of the row.

Insert F5
Convert Table to Text
Converts a table to text and puts the PC cursor at the beginning of the con-
verted text. The table is replaced by the converted text.

Table Navigation Support for Word and Other Applications

There are new navigation keys to be used when in a table. These commands read
the contents of the cell, along with the associated row and column headings. The
same keystrokes can be used to navigate tables in Microsoft Access databases,
Excel, Internet Explorer 5, PowerPoint, and Word, and in Corel QuattroPro and
WordPerfect.
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Ctrl Alt NumPad 5
Reads the row and column coordinates, followed by the cell contents and then
the appropriate row and column headings.
Note: Because of this new function, Ctrl NumPad 5 is now used to read the
current paragraph.

Ctrl Alt Right Arrow
Moves the focus to the next cell in the same row and then announces the
column heading followed by cell contents and then the column number.
Note: New column number only announced in Beginner Verbosity Level. Also:
If there is no cell to the right in the current row the user is told, “end of row”
and then reads the current cell content again.

Ctrl Alt Left Arrow
Moves the focus to the previous cell in the same row and then announces the
column heading followed by cell contents and then the column number.
Note: New column number only announced in Beginner Verbosity Level. Also:
If there is no cell to the left in the current row the user is told, “beginning of
row” and then reads the current cell content again.

Ctrl Alt Down Arrow
Moves the focus to the cell below the current cell and reads the row heading
followed by cell contents and then the row number.
Note: New column number only announced in Beginner Verbosity Level. Also:
If there is no row beneath the current row the user is told, “bottom of column”
and then reads the current cell content again.

Ctrl Alt Up Arrow
Moves the focus to the cell above the current cell and then announces the row
heading followed by cell contents and then the row number.
Note: This function only works if the general verbosity level is set to "begin-
ner." Also: If there is no cell above the user is told, “top of column” and then
reads the current cell content again.

Ctrl Alt Home
Moves to first cell in current table and reads row and column coordinates
followed by contents of the cell.

Ctrl Alt End
Moves to the last cell in current table and reads row and column coordinates
followed by contents of the cell.

Screen Sensitive Help

Insert F1

Screen Sensitive Help provides information about a document, including the
number of tables, the number of fields, and the document protection type.

Screen Sensitive Help has been enhanced to announce information about the
Header/Footer pane, Footnote/Endnote pane, Comments pane, page number
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locations, multiple text columns and margin settings. Also, the document sum-
mary is spoken after information about the current cell or form field.

Forms Support

JAWS now supports forms in Microsoft Word Documents. As the user tabs around
protected forms, the form field prompt, form field type, and content are spoken.
Keystrokes have also been added to focus the user on the first form field in the
document (Ctrl Insert Home) and list all the fields in a document and allow the
user to select and focus on the chosen field (Ctrl Shift L).

When Form fields have the focus, Insert F1 gives Screen Sensitive Help appropri-
ate to the Form field.

An Advanced Feature

If the user is working in documents which show revision changes, JAWS can now
announce the revision type and author, and the user can navigate the Accept or
Reject changes dialog using Read Word In Context/Insert C. Use Ctrl Shift B to
bring up a list of revisions; move the cursor to the selected revision by using Ctrl
Shift V.

Kurzweil 1000 ver 7 (Win 95/98/2000/ME/XP)

Publisher
Kurzweil Educational Systems, Inc.
14 Crosby Drive
Bedford, MA 01730-1402
800-894-5374
http://www.kurzweiledu.com/
Retail Cost: $ 995.00

System Requirements
* Pentium II (300 MHz or higher)
* 128 MB RAM
* 400 MB of available hard disk space
* CD-ROM drive
* Sound Blaster or compatible sound card (16 or 32 bit) with speakers and

microphone
* Single pass flatbed color scanner (100% TWAIN compatible)
* 17-button keypad, game pad, or full size keyboard
* Microphone, if you wish to use the voice command option
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Description
The Kurzweil 1000 is a computer-based reading system that converts printed
material into speech. Users navigate through their documents by using the optional
keypad that comes with it or by using the numeric keypad on a full size keyboard.
In addition to reading documents, users can use dictionary and spelling tools to
enhance their reading. Kurzweil 1000 documents can also be managed from the
keypad.

The Kurzweil 1000 now supports Braille output as well as print text. This option
resides in the Print dialog box. The program can read multi-page TIFF files.

Recommended Uses
The Kurzweil 1000 was designed for non-sighted users, and is useful in any
setting where students need access to print materials. The difference between the
Kurzweil 1000 and the 3000 is that the latter, designed for persons with learning
disabilities, supports graphics, and allows students to visually read on an exact
scan of a page.

Basic Use
1. Basic use involves using the Reading Keypad (see figure 1) to first scan a

document then read it. Refer to the picture below to find these keys. Insert
your document into the scanner facedown. Tap the Start & Stop Scan
button (plus key on numeric keypad) to begin scanning.

2. After the page has been scanned, use the Start & Stop Reading button
(Zero key on numeric keypad) to read through the page.

3. To learn about the other keys, use the Help and Status key.

Intermediate Use
1. Below is the File Management Keypad (see figure 2). To change keypads,

press and hold down the Start and Stop Reading key, then press and release
the Accept key, then release Start and Stop Reading.

File Management Keypad

Advanced Use
1. Below is the Settings Keypad (see figure 3). Change to this keypad and use

the Help & Status key to learn about these keys.

Notes
Be sure to read the installation notes, especially if you have a previous version or
the Kurzweil 3000 installed. In general, the rule is to install the older program
first, then the newer version.
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Figure 1. Reading Keypad

Figure 2. File Management Keypad
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The Kurzweil 1000 no longer has copy protection so no key disk is needed for
installation. If installing on Win NT, be sure to obtain the NT drivers for your
scanner. Also note that Win NT currently does not support USB scanners.

Kurzweil 3000 ver. 7 (Win 95/98/NT/2000/XP)

Publisher
Kurzweil Educational Systems, Inc.
14 Crosby Drive
Bedford, MA 01730-1402
Phone 1-800-894-5374
FAX 1-781-276-0650
http://www.kurzweiledu.com/index.html
Retail Cost: $ 1895.00 color and $ 1095 black and white

Figure 3. Settings Keypad
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System Requirements
* Pentium PC Processor (preferably 166MHz or higher)
* 128 MB RAM - Black and white scanning
* 128 MB RAM - Color scanning
* 2 MB Video RAM
* 400 MB of available hard disk space (with 80 MB reserved as swap space

for virtual memory)
* CD-ROM drive
* Sound Blaster or compatible sound card (16 or 32 bit)
* Microphone and speakers
* SVGA Monitor (resolution of 800x600 or higher)
* Fully TWAIN compatible scanner (Scan/Read only)
* Full size keyboard and mouse
* Windows 95/98/NT/2000/XP operating system

Description
The Kurzweil 3000 is a computer-based reading system that converts printed
material into speech. Users can hear printed words spoken aloud as they read them
on the computer screen. In addition to reading documents, users can use dictionary
and phonetic spelling tools to enhance their reading. Scanned pages appear on the
screen as they appear in the original material. As the Kurzweil 3000 reads, it
highlights each word and its context. The reading voice, background/foreground
colors, and text size are easily adjustable.

Recommended Uses
The Kurzweil 3000 was designed for sighted users who have difficulty reading. It
could be used in any setting where students need access to print materials. It may
also serve as a writing environment for users who would benefit from its special
features. Because there are many on-screen controls available, it is not as suitable
as a reading machine for non-sighted students as the companion product the
Kurzweil 1000 which provides easy access for non-sighted users.

Basic Use
1. Start the Kurzweil 3000. Enter your name if prompted. A window appears

with a number of menus, buttons, and combo boxes.

2. Run the mouse pointer over the buttons, pausing over each without click-
ing and read the tool tips that appear which describe each button's func-
tion.

3. To scan a document, place it in the scanner and click the Scan button.

4. After the image of the document appears on the screen, resize it to your
desired size by choosing a percentage in the Zoom box or by clicking on
the little arrows on the box.
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5. Read the document by clicking on the Play button. Notice the Play button
changes to a Pause button to be clicked when you wish to stop reading.

6. To get more information on a word, highlight any word in the document by
double-clicking on it. Click on the Dictionary button in the toolbar.

7. Click the Read button to hear the definitions read aloud. To see a list of
words with similar meanings, click Get Synonyms.

Intermediate Use
1. Click the right mouse button in the document to see a context menu of

choices to make. This method may prove to be quicker.

2. To select a reading unit, choose from the Read By list box either by word,
by phrase, by sentence, by line, or by paragraph.

3. To select a reading mode, choose from the Read Mode list box. Continu-
ous mode will read until you stop it with a mouse click or clicking on the
pause button. If you choose Self-Paced, reading will pause at the end of
whatever reading you have selected.

Installation
The installation is very simple, just insert the CD and follow the on-screen direc-
tions. The authorization floppy disk must be in the A: drive during installation
when it is automatically installed. There are three authorizations on the floppy
disk. If you need to uninstall, there will be a step in the process that places the
authorization back on the floppy disk.

However, if you have a previous version or a version of Omni/Kurzweil 1000 the
sequence of installation becomes important. As a general rule, install the older of
the Kurzweil programs first, then the newer one to avoid conflicts.

If installing on Win NT, be sure to obtain the NT drivers for your scanner.

ZoomText Xtra (Win 95/98/2000/XP)

Publisher
Ai Squared
P.O. Box 669
Manchester Center, VT 05255
(802) 362-3612
http://www.aisquared.com/
Retail Cost: see notes section
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System Requirements
* 486 or higher processor; Windows 3.1 or 95/98; 16,256 or High Color

display driver; minimum 8 MB RAM (16 MB preferred); Windows sound
card or SSIL speech synthesizer (required for levels 2 and 3 only).

Description
ZoomText Xtra comes in two levels: Level 1 is a screen magnifier for the Win-
dows 95/98 environment. Level 2 offers a fully integrated magnifier and screen
reader, designed specifically for the low-vision computer user.

Another innovative feature of ZoomText Xtra is its document reading module,
called DocReader. Existing in all product levels, DocReader is a full-screen
environment for reading text from any Windows application. DocReader can
automatically read through complete documents, including web pages and email.

Recommended Uses
ZoomText is intended for use by persons with low vision. It may also be of value
to individuals with learning disabilities. ZoomText has been designed so that there
is a corresponding hot key for every selection that is generated by a mouse click.
Check the documentation for the extensive lists of hot keys. A productive
ZoomText user will more than likely use some hotkeys to generate frequently
repeated actions.

Basic Use
1. To start ZoomText, choose the ZoomText icon from the Start menu.

2. When ZoomText is active, pressing Alt Delete turns it off. To turn
ZoomText back on, press Alt Insert.

3. When ZoomText is active, pressing Alt Insert or Ctrl Shift U will display
the ZoomText User dialog box. Options may be selected from menus or
from Tool icons. Selections may be made from the keyboard or with a
mouse.

4. Choose Contents from the Help menu and browse through the excellent
descriptions of the programs functions.

Intermediate Use

Enlarging and Changing Text Size

Text may be enlarged in two ways: from the keyboard, Alt followed by the Plus or
Minus key will enlarge or reduce text size.

From the ZoomText menu bar: from the Options menu select Display then click
the Magnification tab if it is not already the front tab. From this dialog box it is
possible to set horizontal and vertical size, whether the text is proportional (e.g.
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3X [Horizontal] by 3X [Vertical] or not, and whether the text is to have smoothed
edges, possible with 256 display monitors).

Choosing Display Style

From the ZoomText menu bar: From the Window menu select the display desired.
The default view is Overlay. This view places a window in the lower right quarter
of the screen. Cursor and Pointer tracking are on. Moving the mouse pans the
screen display in this viewing window. The remaining 75% of the screen remain at
normal magnification.

There are five main display options: Full Screen, Lens (a movable, sizable rect-
angle), H-split (horizontal split) and V-Split (vertical split).

Overlay

The default setting for ZoomText places the Overlay window in the lower quad-
rant of the screen. Moving the mouse pans the screen; with tracking on, activities
using the cursor and mouse are focused in the window.

Re-sizing the Overlay View

It may be useful for students with learning disabilities to re-size the overlay so that
only one line of text is magnified. This environment can be used for writing or
reading. To do this

1. Bring up the User dialog box with Alt Insert or with Shift Control U.

2. Select the Re-size icon (the 1st from the left in the lower row of Tool
icons.)

3. Click the mouse pointer on one of the rectangular "handles" which now
appear on the outline of the current overlay window.

4. Click and drag the window borders to the desired positions (left border to
the left margin, lower border up a bit, top border down as far as possible,
right border a little to the left, if necessary.) Click the right mouse button to
keep the desired size.

Full Screen

For persons comfortable with the entire screen magnified. Moving the mouse
(with tracking on) pans the magnified view.

H-Split

A magnified view of the screen is displayed in the lower half of the screen. Mov-
ing the mouse pans the view in the window. Cursor track places cursor activity in
this view.
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Saving Configurations

Configurations are easily saved or loaded into memory. Because a user can easily
save a personalized configuration, it is easy to make ZoomText work in a highly
customized setup.

To Save a Setup

1. Make necessary adjustments to ZoomText values.

2. Bring up the ZoomText User window with Alt Insert.

3. Open the File menu and select Save As.

4. Name the file (e.g., suzy). ZoomText automatically adds a .zxc extension.

5. The new configuration file is now listed at the bottom of the File menu,
and can be loaded from there.

Loading Configurations

There are several different ways to load a configuration: From the File menu,
select Open and select the file. Or from the File menu, select the name of the
configuration from the bottom of the file menu if it is there. During a work ses-
sion, once a configuration has been loaded, its name is placed at the bottom of the
File menu.

How to Scroll Text

Having text scroll by in a magnified view can be an efficient way for some per-
sons to read text. Entering the hot key command Ctrl Shift S brings up the Scroll
icon. Click and hold down the mouse button and the screen starts the scrolling
action in the direction of the mouse drag. Click the right mouse button or press
Escape to leave the scroll mode.

DocReader

Note: To go to DocReader when in an open document (e.g., in Word) use the Ctrl
Shift R hot key.

To explore the DocReader from the ZoomText window, do the following

1. Click the DocReader button, the open book icon without the pointer, to
launch DocReader to read text from the last active application. The
DocReader module is a reading environment that reformats, magnifies and
speaks text (level 2 & 3 only) from any Windows application.

2. The text of the last opened application is reformatted into the DocReader
window and a toolbar appears at the top. This toolbar is used to read
through the text in a method similar to using a tape recorder’s buttons.
Click on the first button to start reading through the enlarged text. Click it
again to stop. For more detailed descriptions of the buttons, see the de-
scriptions from the Help menu.
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3. With Level 2, speech output is also possible and can be controlled either
from the DocReader window or the icons on the application. The icons
control the various aspects of the speech function. To learn each icon’s
function, from the ZoomText Xtra application, click on the ? icon, then on
the icon you wish to learn about. A short description will pop up which
explains the function of that icon.

Notes
Level 1 Pricing

ZX Level 1 (for Windows 95/98 and 3.1) $395
ZX Level 1 Plus (includes ZoomText for DOS) $595
ZX Level 1 Upgrade * (from older ZoomText versions) $95

Level 2 Pricing
ZX Level 2 (for Windows 95/98 and 3.1) $595
ZX Level 2 Plus (includes ZoomText for DOS) $795
ZX Level 2 Upgrade * (from ZX Level 1) $200
(from older ZoomText versions) $195

Site License Pricing
Site license options are no longer available from AiSquared. For details,
contact AiSquared regarding volume pricing.

Installation
Current versions of ZoomText Xtra (version 7.1 and higher) now allow JAWS 4.0
functionality in the Windows 2000/XP operating system. It is necessary to install
ZoomText Xtra before installing JAWS 4.0 due to issues with the display drivers.
If running a Windows XP operating system, it is highly recommended to upgrade
to version ZoomText Xtra version 7.11.

Network
Early versions allowed users to specify both a directory for the hardware profile
file, ZxHdw.ini, and the user configuration file, Username.zxc, so unique user
settings can be preserved. This setup allows the program to be stored on a server,
the local hardware profile to be stored on the local computer, and a particular user
configuration to be stored on the server so that user has access to that configura-
tion from any computer that has access to the server. To do this, add the following
to the command line of the ZoomText icon

/c=c:\temp w:zt5\users\username

where /c= is a switch to allow the following process, c:\temp is an example path to
a directory that stores the local hardware profile file and w:zt5\users\username is
an example path to a directory on the server that stores username’s configuration
file. Note that there must be a space before the /c=c:\temp part and a space after
that part to separate the two additions to the command line.
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The names of ZoomText configuration files, which are loaded by LoadConfigFile
hotkeys, are now stored in a global .INI file. This allows you to switch configurations
without losing the configuration hotkey settings. A new file, ZXCFILES.INI, contains
the names of the hotkey configuration files and is stored in your ZoomText directory
(or in the directory specified by the /C= command line parameter). While it is possible
to setup ZoomText in a server environment, newer versions of the ZoomText Xtra
software appear to be more stable with a local installation.

TextAloud MP3 ver. 1.415 (Win 98/2000/XP)

Developer
NextUpTech.com
http://www.nextup.com
Retail Cost: $19.95 (per user)

Description
TextAloud MP3 uses “Text-to-Speech” technology to record text information to an
audio format. TextAloud MP3 also gives you the option of reading text and saving
it to a file so you can listen later. You can create ordinary wav files, or save the
output in compressed MP3 format. Create MP3 files from your email, news
articles, and any text you want, and download the content to your portable MP3
player.

TextAloud MP3 retrieves text from the clipboard (or imports from text files) and
loads the text as 'articles'. Once you've loaded one or more articles, you use VCR-
like controls to read the text either to your speakers, or audio files.

Basic Use
1. Copy text information to the TextAloud MP3 clipboard.

2. Select the output audio format you want under the File Options tag. This
will be either a .wav or MP3 format.

3. Choose the MP3 quality from the combo box. For text, a quality rating of
32kbps/16.00KHz/Stereo is sufficient to produce high-quality audio
output.

4. Choose a Write to File Speed of less than 20x. This determines the amount
of CPU usage that will be dedicated to the processing of the text-to-speech.

5. Choose a File Output Directory on the hard drive.

6. Select Read to File from the Read menu bar, or press Ctrl+F7. This will
begin the speech to text processing. Depending on the output specifica-
tions, TextAloud MP3 will complete the text to speech conversion in a
several minutes.
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Single-Article vs. Multi-Article Mode

TextAloud MP3 provides two modes for users to convert text to speech. Using the
single-article mode, each article copied into TextAloud MP3 replaces the previous
article. TextAloud can then read the current article contained on the clipboard.

TextAloud MP3 also offers a Multi-Article mode that allows the user to add to a
list of articles on the clipboard before reading each article. Users have the option
of producing one audio file or multiple audio files of the text contained on the
clipboard.

Pronunciation Editor

The Pronunciation Editor can be accessed from the Options menu bar. This editor
allows the user to specify how TextAloud MP3 will pronounce words. Currently,
the Pronunciation Editor supports only Microsoft text-to-speech engines. To
change the pronunciation of a word

* Start the Pronunciation Editor by clicking on the Options menu bar
command.

* Enter the word you want to modify.
* If the word is not present in the editor, you will have the option to add the

word to the dictionary. If this is a new addition, TextAloud will ask for the
phonetic spelling of the specific word.

* If the word is present in the editor, TextAloud will ask if you wish to
change the pronunciation of the word or delete the word from the
dictionary.

Hotkey Commands

Hotkey commands allow the user to move text into the TextAloud interface easily
and quickly in order to hear the content of the file. There are several different
hotkey command options that can be customized. To make changes to the hotkey
commands, select the HotKey Setup from the Options menu bar.

To import new text into TextAloud and have it read automatically
* Select the combo box next to the Import New option
* Choose a number, letter, or Function key from the combo box option
* Select a modifier key (i.e., Ctrl, Alt, Shift)

To automatically speak highlighted text in a program without importing to
TextAloud

* Select the combo box next to the Speak Text option
* Choose a number, letter, or Function key from the combo box option
* Select a modifier key (i.e., Ctrl, Alt, Shift)

To stop TextAloud from speaking
* Select the combo box next to the Stop Speaking option
* Choose a number, letter, or Function key from the combo box option
* Select a modifier key (i.e., Ctrl, Alt, Shift)
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Playing TextAloud MP3 files

TextAloud MP3 will produce audio files in a .wav or MP3 file format. The advan-
tage of the MP3 format is the compression of a file to a relatively small size while
maintaining high quality audio output. If choosing a portable MP3 player, identify
a product that uses flash memory to save files. Flash memory of at least 64Mb is
sufficient for several book chapters.


